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About this Guide 
This guide describes how to install the IP Office Applications from the IP Office User Applications CD. 
The guide is written with the assumption that the system administrator is an experienced IP Office 
Manager, Phone Manager, Voicemail Pro and SoftConsole administrator.  

The guide covers the installation, configuration and administration requirements for the following 
applications: 

 Conferencing Center 
This covers both the Web Scheduler and Web Client 

 SoftConsole 

 Phone Manager 
  

The Appendix contains information that is applicable to more than one of the IP Office applications 
covered in this guide. 

Further information about Avaya IP Office is available from www.avaya.com/support and also 
www.avaya.com/ipoffice/knowledgebase. 
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Conferencing Center 
Installation 
Overview 
This part of the guide covers the installation, configuration and administration of IP Office Conferencing 
Center. It is intended for the system administrator and the Conferencing Center administrator.  

Conferencing Center for IP Office comprises of a Windows Service that handles the communication with 
IP Office, Voicemail Pro and SoftConsole via the IP switch.  

Conferencing Center interacts with IP Office in the following ways: 

 Shares ports and audio channels with the IP Office. 

 Uses bridge number/s from which participants can join a conference. 

 The SoftConsole operator can transfer participants to a conference and create an "immediate" 
conference.  

 Phone Manager can be configured to connect directly to the Conferencing Center Scheduler and 
Web Client GUI. 

You have the option to install both the scheduler and web client host applications on the same server or 
on to separate servers for security and access purposes. The distinctions between the two applications 
are: 

 Scheduler - Requires the installation of a MSDE database (available on the Conferencing Center 
CD) and allows access to the scheduling of conferences and general maintenance. The 
Scheduler is used to book conferences. 

 Web Client Host - Allows conference participants to access a web conference interface that 
supplements the audio conference.  

Conferencing Center is supported on the following IP Office Control Units with IP Office Software version 
3.0 or above: 

 Small Office Edition. 

 IP 403 Office. 

 IP 406 Office. 

 IP 412 Office. 
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Setup Options 
Depending on your company's network configuration, Conferencing Center can be setup in several 
ways. Below are three available options. 

Conferencing  Center Setup: Option 1 (recommended option) 

 
 

This makes the Web Client Host accessible to external users while keeping the booking site and its 
database more secure. 
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Conferencing Center Setup: Option 2 

 

 

With this setup, the following port issues need to be kept in mind: 

 Conferencing Center installs by default to port 25 (for email) and port 80 (to communicate with 
the web server). 

 Check that port 8089 is not being used by something else on the Conferencing server because it 
is needed for the Conferencing Center Web Client to talk to the IP Office control unit. If there is a 
conflict, use another port by doing the following: 

1. Open Inetpub. 

2. Double-click wwwroot. 

3. Double-click AVECS. 

4. Open the Web.config file with your preferred editing tool. 

5. Change the port number (highlighted characters) on the following code string: <add 
key="RemotePoint" 
value="tcp://localhost:8089/Avaya.ECS.ECSConferenceService.RemotingInterface"/>  
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Conferencing Center Setup: Option 3 

 
If this option (a firewall placed between the web server and Voicemail Pro server) is selected, the 
following port issues need to be kept in mind: 

 Conferencing Center installs by default to port 25 (for email) and port 80 (to communicate with 
the web server). 

 Port 69 has to be kept open for TFTP requests from Conferencing Center Scheduler to the IP 
Office control unit. 

 Port 50801 has to be kept open for the Conferencing Center Server to talk to the IP Office control 
unit. 

 Check that port 8089 is not being used by something else on the Conferencing server because it 
is needed for the Conferencing Center Web Client to talk to the IP Office control unit. If there is a 
conflict, use another port by doing the following: 

1. Open Inetpub. 

2. Double-click wwwroot. 

3. Double-click AVECS. 

4. Open the Web.config file with your preferred editing tool. 

5. Change the port number (highlighted characters) on the following code string: <add 
key="RemotePoint" 
value="tcp://localhost:8089/Avaya.ECS.ECSConferenceService.RemotingInterface"/>  
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Pre-Installation Requirements 
Check the following Server and PC requirements before attempting to install Conferencing Center.  

Note 

 64 Bit versions of Microsoft operating systems are not currently supported with IP Office 
applications. 

General 

Details 

License Conferencing Center 

Languages English, French, German, Italian, Latin Spanish, and Swedish. 

Additional Voicemail Pro 

MS Internet Explorer 6.0 or higher 

IIS 5 or higher. IIS must be installed before .NET. For more information, see IIS 
Configuration. 

(Optional) Microsoft Office. Required if Microsoft files are to be converted to MHT files. 

 

Minimum Server specification 

RAM HD Pentium Celeron AMD XP 
Pro 

2000 
Pro 

2000 
Server 

2003 
Server 

512MB 80MB 2.8GHz Not 
tested. 

Athlon XP 
3000+ 

Athlon64 

    

Note 

 Windows XP Professional or 2000 Professional can be used but would typically support a 
maximum of 10 web clients. To support more than 10 clients a server with IIS is required.  

 

Minimum PC specification  

RAM HD Pentium Celeron AMD XP 
Pro 

2000 
Pro 

2000 
Server 

2003 
Server 

Not 
specified. 

Not 
specified. 

Any Any Any     

Note 

 Any desktop machine can be used for the Conferencing Center Web Client, as long as the PC is 
capable of running IE6. 
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IIS Configuration 
IIS 5 or higher must be installed and configured before installing Conferencing Center. Install IIS by 
following the instructions for the type of operating software that you are using. When IIS has been 
installed follow the instructions to configure it. 

Note 

 If .NET has been installed, remove it before installing IIS. .NET will automatically be installed 
from the Conferencing Center installation disk. 

 

To install IIS: 

1. Insert Windows CD. 

2. Click the Start > Settings > Control Panel. 

3. Double click Add/Remove Programs. 

4. Click Add/Remove Windows Components. 

5. Select IIS. 

6. Click Next. 

7. Click Finish to the Windows Component Wizard prompt. 

 

IIS needs to be configured to a local system setting (for all installation options). 

To configure IIS: 

1. Click the Start > Control Panel > Administrative Tools. 

2. Double click Internet Information Services (IIS) Manager. 

3. Select PCName (local computer). 

4. Double click Application Pools. 

5. Select DefaultAppPool, right click and select Properties. 

6. Select Identity tab. 

7. Select the drop down box and set to Local System.  

8. Select OK. 

 

Microsoft Internet Explorer Configuration 
If you are using a proxy server the following configuration is required. 

1. From an Internet Explorer window, select Tools. 

2. Select Internet Options. 

3. Select Connections tab. 

4. Select LAN Settings. 

5. Check Bypass proxy server for local addresses. 

6. Click OK. 
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Network Configuration 
The server PC with the Conferencing Center Scheduler application installed should be configured and 
tested for TCP/IP networking. 

1. We strongly recommend that the Conferencing Center server PC with the Scheduler application 
installed is connected to the IP Office Control Unit via a switching LAN hub. If this is not possible, 
then the server should be directly connected to the IP Office Control Unit. 

2. This server PC must have a fixed IP address. While PC's in a DHCP network may retain the 
same IP address between reboots, this is not guaranteed.  

 If the IP Office is acting as a DHCP server, it defaults to using the address range of 
192.168.42.1 to 192.168.42.200 for DHCP clients. This leaves the address range of 
192.168.42.201 to 192.168.42.254 for devices that require fixed IP addresses.   

 

General Configuration 
Before installing Conferencing Center check the following requirements. 

 Voicemail Pro. 
Conferencing Center can be installed on to a separate server PC from Voicemail Pro. Even 
though Voicemail Pro configuration is necessary to make full use of Conferencing Center 
features, Conferencing Center communicates with VM Pro via the IP Office Control Unit, not with 
VM Pro directly. 

 Port Settings. 
Conferencing Center installs by default to port 25 (for email) and port 80 (to communicate with 
the web server). For port details relating to specific Conferencing Center setups, see Setup 
Options. 

 Email 
The Conferencing Center server PC with the Web Booking application installed must have at 
least one SMTP server defined and available. This is necessary if you plan to use email for 
sending conference notifications and voting results to conference hosts.   

 The License for IP Office Conferencing Center is required. 

 Switch off any PC and hard disk sleep/power down modes. 
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Installing Conference Center 
Overview 
Conferencing Center gives you the option to install both the booking and web client applications on the 
same server or onto separate servers for security and access purposes. This information needs to be 
decided upon prior to the installation and appropriate hardware made available. 

Installing the Web Client on a separate server is useful for sites where their web servers reside outside 
the firewall or are hosted at ISPs. This installation option makes the Web Client accessible to external 
users while keeping the booking site and its database secure.  

Follow the instructions to:  

 Full Installation 
Installs both the Web Scheduler and Web Client applications. For more information, see Perform 
a Full Installation. 

 Web Scheduler only Installation 
Installs only the Web Scheduler application. For more information, see Web Scheduler only 
Installation. 

 Web Client Host Installation 
Install only the Web Client application. For more information, see Web Client Host Installation.  

 Upgrade Conferencing Center 
When you upgrade the application you can perform: 

 A full upgrade where both the Web Scheduler and Web client applications are on one 
machine.  For more information, see Upgrade - Full Installation. 

 A split installation where the Web Scheduler and Web Client applications are installed on 
different machines.  For more information, see Upgrade - Split Installation. 

 



Conferencing Center 

Applications Installation & Administration Manual Page 11 
IP Office 3.2 15-601133 Issue 1 (7 June 2006) 

Perform a Full Installation 
Make sure that you have followed all the pre-installation requirements before continuing with the 
installation of Conferencing Center. You will need the IP Office IP Address and Password.  

To install the Web Scheduler and Web Client applications on the same server PC: 

Step 1 - Install Microsoft SQL Server Desktop Engine (MSDE).   

1. Insert the IP Office Conferencing Center CD. 

2. Open My Computer. 

3. Open your CD directory. 

4. Double-click the MSDE folder. 

5. Double click ConferencingCenter_MSDE_SP3.exe. It might take a few minutes to install MSDE. 

6. The message 'You must restart the system for the configuration changes made to Microsoft SQL 
Server Desktop Engine to take effect. Click Yes to restart now or No if you plan to manually 
restart later' will open. Click Yes.  

Step 2 - Install Conferencing Center.  

1. Open My Computer. 

2. Open your CD directory. 

3. Double-click setup.exe. The 'select the language for installation' window opens. Select the 
installation language from the drop down box. 

4. Click OK. The 'Preparing to Install' screen opens. 
If .NET 1.1 is not installed the following message is shown: 
Conferencing Center optionally uses the Microsoft (R) .NET 1.1 Framework. Would you 
like to install it now?  

 Click Yes. The license Agreement window opens select I agree.  

 Click Install. Microsoft .NET Framework 1.1 is installed. 
When the message 'Installation of Microsoft .NET framework 1.1 is complete' opens, click 
OK. 

5. The 'Welcome to the InstallShield Wizard for Conferencing Center' window opens.  

6. Click Next. The 'Setup Type' window opens. 

7. Select Full Install.  

8. Click Next. The 'Choose Destination Location' window opens. Leave the directory setting at 
default unless absolutely necessary.  

9. Click Next.  The 'Start Copying Files' window opens. Settings can be changed at this stage.   

10. Click Back to review or change any settings 
or 
Click Next to begin copying the files. The 'Setup Status' window opens.   
The files may take a few minutes to install. The 'IP Office Connection Details' screen opens.  

11. Enter the IP Office Control Unit's IP Address and Password.  

12. Click Next. The 'Conference Center Login Information' screen opens. Enter a user name and 
password to create a Conferencing Center Administrator's account. Password must be between 
5-50 alpha numeric characters.   

Note 

 Record the user name and password. If either is 'lost' they can not be re-set. If either the 
user name or password are lost a full installation of Conferencing Center needs to be done. 

13. Click Next. The 'InstallShield Wizard Complete' window opens. 

14. Click Finish to exit the wizard.  
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Web Scheduler Only Installation 
The conference booking application can be installed without the web client. 

To install the Web Scheduler: 

Step 1 - Install Microsoft SQL Server Desktop Engine (MSDE).   

1. Insert the IP Office Conferencing Center CD. 

2. Open My Computer. 

3. Open your CD directory. 

4. Double-click the MSDE folder. 

5. Double click ConferencingCenter_MSDE_SP3.exe. It might take a few minutes to install MSDE.  

6. The message 'You must restart the system for the configuration changes made to Microsoft SQL 
Server Desktop Engine to take effect. Click Yes to restart now or No if you plan to manually 
restart later' will open. Click Yes.  

Step 2 - Install Conference Center Web Scheduler 

1. Open My Computer. 

2. Open your CD directory. 

3. Double-click setup.exe. The 'select the language for installation' window opens. Select the 
installation language from the drop down box. 

4. Click OK. The 'Preparing to Install' screen opens. 
If .NET 1.1 is not installed the following message is shown: 
Conferencing Center optionally uses the Microsoft (R) .NET 1.1 Framework. Would you 
like to install it now?  

 Click Yes. The license Agreement window opens select I agree.  

 Click Install. Microsoft .NET Framework 1.1 is installed. 
When the message 'Installation of Microsoft .NET framework 1.1 is complete' opens, click 
OK. 

5. The 'Welcome to the InstallShield Wizard for Conferencing Center' window opens.  

6. Click Next. The 'Setup Type' window opens. 

7. Select Web Booking.  

8. Click Next. The 'Choose Destination Location' window opens. Leave the directory setting at 
default unless absolutely necessary.  

9. Click Next.  The 'Start Copying Files' window opens. Settings can be changed at this stage.   

10. Click Back to review or change any settings 
or 
Click Next to begin copying the files. The 'Setup Status' window opens.   
The files may take a few minutes to install. The 'IP Office Connection Details' screen opens.  

11. Enter the IP Office Control Unit's IP Address and Password.  

12. Click Next. The 'Conference Center Login Information' screen opens. Enter a user name and 
password to create a Conferencing Center Administrator's account. Password must be between 
5-50 alpha numeric characters.   

Note 

 Record the user name and password. If either is 'lost' they can not be re-set. If either the 
user name or password are lost a full installation of Conferencing Center needs to be done. 

13. Click Next. The 'InstallShield Wizard Complete' window opens. 

14. Click Finish to exit the wizard.  
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Web Client Host installation 
If the Conferencing Center Web Booking application is installed on another server, the Web Client 
application needs to be installed to make use of the web conferencing features.  

To install the Web Client: 

1. Open My Computer. 

2. Open your CD directory. 

3. Double-click setup.exe. The 'select the language for installation' window opens. Select the 
installation language from the drop down box. 

4. Click OK. The 'Preparing to Install' screen opens. 
If .NET 1.1 is not installed the following message is shown: 
Conferencing Center optionally uses the Microsoft (R) .NET 1.1 Framework. Would you 
like to install it now?  

 Click Yes. The license Agreement window opens select I agree.  

 Click Install. Microsoft .NET Framework 1.1 is installed. 
When the message 'Installation of Microsoft .NET framework 1.1 is complete' opens, click 
OK. 

5. The 'Welcome to the InstallShield Wizard for Conferencing Center' window opens.  

6. Click Next. The 'Setup Type' window opens. 

7. Select Web Client Host.  

8. Click Next. The 'IP Address' window opens. Enter the IP Office Control Unit's IP address. 

9. Click Next. The 'Start Copying Files' window opens. The files may take a few minutes to install. 
When they have been installed the 'InstallShield Wizard Complete' window opens. 

10. Click Finish to exit the wizard.  
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Upgrade Procedure 
Overview 
With an upgrade you have the option to keep the full install of Conferencing Center on the one server PC 
or make the installation split. 

 A full install (both the Web Booking and Web Client Host applications on the same server PC)  

 A split install (the Web Booking application installed on one server and Web Client Host 
application on another server PC)  

 

Upgrade - Full Installation 
To upgrade to and keep the full installation on one server PC: 

1. Click Start > Settings > Control Panel > Add/Remove Program. 

2. Select Conferencing Center and click on Change/Remove. The InstallShield Wizard will start. 

3. At the 'Welcome' window select Remove.  

4. Click Next. The application will be deleted. The database will be not be effected. 

5. Open My Computer. 

6. Open your CD directory. 

7. Double-click setup.exe. The 'select the language for installation' window opens. Select the 
installation language from the drop down box. 

8. Click OK. The 'Preparing to Install' screen opens. 
If .NET 1.1 is not installed the following message is shown: 
Conferencing Center optionally uses the Microsoft (R) .NET 1.1 Framework. Would you 
like to install it now?  

 Click Yes. The license Agreement window opens select I agree.  

 Click Install. Microsoft .NET Framework 1.1 is installed. 
When the message 'Installation of Microsoft .NET framework 1.1 is complete' opens, click 
OK. 

9. The 'Welcome to the InstallShield Wizard for Conferencing Center' window opens.  

10. Click next. The 'Setup Type' window opens. 

11. Select Full Install.  

12. Click Next. The 'Choose Destination Location' window opens. Leave the directory setting at 
default unless absolutely necessary.  

13. Click Next. The 'Start Copying Files' window opens. Settings can be changed at this stage.   

14. Click Back to review or change any settings 
or 
Click Next to begin copying the files. The 'Setup Status' window opens.   
The files may take a few minutes to install. The 'IP Office Connection Details' screen opens.  

15. Enter the IP Office Control Unit's IP Address and Password.  

16. Click Next. The 'Conference Center Login Information' screen opens. Enter a user name and 
password to create a Conferencing Center Administrator's account. Password must be between 
5-50 alpha numeric characters. Make note of the user name and password. 

Note 

 Record the user name and password. If either is 'lost' they can not be re-set. If either the 
user name or password are lost a full installation of Conferencing Center needs to be done. 

17. Click Next. The 'InstallShield Wizard Complete' window opens. 

18. Click Finish to exit the wizard.  
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Upgrade - Split Installation 
If you want to make the installation split, it is advisable to keep the existing Conferencing Center server 
PC as the Web Booking server and install the Web Client Host on to another server PC.  

To upgrade the existing server PC with ONLY the new Conferencing Center Web Booking application: 

1. Click Start > Settings > Control Panel > Add/Remove Program. 

2. Select Conferencing Center and click on Change/Remove. The InstallShield Wizard will start. 

3. At the 'Welcome' window select Remove.  

4. Click Next. The application GUI will be deleted. The database will be not be effected. 

5. Open My Computer. 

6. Open your CD directory. 

7. Double-click setup.exe. The 'select the language for installation' window opens. Select the 
installation language from the drop down box. 

8. Click OK. The 'Preparing to Install' screen opens. 
If .NET 1.1 is not installed the following message is shown: 
Conferencing Center optionally uses the Microsoft (R) .NET 1.1 Framework. Would you 
like to install it now?  

 Click Yes. The license Agreement window opens select I agree.  

 Click Install. Microsoft .NET Framework 1.1 is installed. 
When the message 'Installation of Microsoft .NET framework 1.1 is complete' opens, click 
OK. 

9. The 'Welcome to the InstallShield Wizard for Conferencing Center' window opens.  

10. Click Next. the 'Setup Type' window opens. 

11. Select Web Booking.  

12. Click Next. The 'Choose Destination Location' window opens. Leave the directory setting at 
default unless absolutely necessary.  

13. Click Next. The 'Start Copying Files' window opens. Settings can be changed at this stage.   

14. Click Back to review or change any settings 
or 
Click Next to begin copying the files. The 'Setup Status' window opens.   
The files may take a few minutes to install. The 'IP Office Connection Details' screen opens.  

15. Enter the IP Office Control Unit's IP Address and Password.  

16. Click Next. The 'Conference Center Login Information' screen opens. Enter a user name and 
password to create a Conferencing Center Administrator's account. Password must be between 
5-50 alpha numeric characters. Make note of the user name and password. 

17. Click Next. The 'InstallShield Wizard Complete' window opens. 

18. Click Finish to exit the wizard.  

 

To install the Web Client Host on a second server PC: 

Follow the instructions within for installing the Web Client Host. Remember to redirect users to the new 
Web Client Host's URL by logging on to the Conferencing Center Scheduler as an administrator, 
accessing the Configuration window and entering the new URL into the URL for Web Client field. For 
more information, see Conferencing Center Configuration. 
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Configuration 
Overview 
After installation the system must be configured to enable Conferencing Center to work. All the changes 
are explained in the following sections. 

 License Keys. 
Conferencing Center does not work if the correct license keys are not entered. For more 
information, see Entering License Keys. 

 Manager. 
The IP Office Manager application needs to be updated to enable users to join a conference 
using a Bridge Number. Changes must be made to individual Phone Manager users if they 
require direct access to Conferencing Center Scheduler and Client. For more information, see IP 
Office Manager Configuration. 

 Internet Options. 
The internet security settings must be changed if a Conferencing Center user needs to convert 
Microsoft files to MHT files. MHT files are the only file type that can be uploaded into a web 
conference presentation. For more information, see Internet Security Changes. 

 Voicemail Pro. 
Upon proper installation and configuration of Conferencing Center, it is already connected to 
Voicemail via the switch. The basic function of inviting a participant to join a conference is set up. 
Actions can be created, such as a short code for internal participants to join a conference, by 
configuring Voicemail Pro. For more information, see Create a Conference Access Short Code 
and Conferencing Center Failure Routes. 

 Conferencing Center Scheduler. 
Once Conferencing Center is installed, configuration changes can be made in the Conferencing 
Center Scheduler. For more information, see Conferencing Center Configuration. 
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IP Office Manager Configuration 
The IP Office Manager application needs to be updated to enable users to join a conference using a 
bridge number. Changes also need to be applied to enable Phone Manager users direct access to both 
the Conference Center Scheduler and Client. 

Create a Bridge Number 
One way to join a booked conference is by dialing in via a Bridge Number. Before this can take place, a 
bridge number must be set up. There are several methods for setting up a bridge number, depending on 
how the telephone system is configured with the local telephone company. We have provided one 
sample method, based on an incoming call route. It assumes that in Voicemail Pro, there is a 
Conferencing Center module.  

To create a Bridge Number: 

1. Open IP Office Manager. 

2. Click and open the IP Office system configuration associated with Conferencing Center. 

3. In the Navigation pane click  Incoming Call Route.  

 In the Line group ID field, enter a line group number you want to assign for Conferencing 
Center.   

 In the Destination field, input the Conferencing Center module name that was created in 
Voicemail Pro, preceded by VM:.   

4. Define which line(s) you want assigned for conferencing under  Line.   

 In the Incoming Group ID field, enter the line group number that was set up in the 
incoming call route.   

5. Save and merge configuration. 

 Contact your local telephone company to complete the set-up for a bridge number. 

 

Configuration for Phone Manager users 
If Phone Manager 3.0 or above is available users can access the Conferencing Center Scheduler and 
Web Client via two buttons within Phone Manager. To make Conferencing Center accessible using 
Phone Manager, the system and then individual Phone Manager users need to be configured. 

To configuring the system: 

1. Open IP Office Manager. 

2. Click and open the IP Office system configuration associated with Conferencing Center. 

3. In the Navigation pane click  System. 

4. Click System tab. 

5. Enter only the Conferencing Center web server name as follows (without the quotation marks), 
"http://webserver_name/" in the Conferencing Center URL field. This can be the web server PC 
name or IP address. 

6. Click OK. 

7. Click Save. 

8. Select Merge. 

9. Click OK. 
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To configuring individual users: 

For users who want direct access to Conferencing Center using Phone Manager, make the following 
configuration changes in Manager: 

1. Repeat steps 1-2 from "Configuring the System" above if necessary. 

2. In the Navigation pane click User. 

3. Click the required user name/extension. 

4. Click the Phone Manager Options tab. 

5. Tick Book with Conferencing Center in Phone Manager. 

6. Click OK. 

7. Repeat for each user who requires access to Conferencing Center using Phone Manager. 

8. Click Save. 

9. Select Merge. 

10. Click OK. 

 

When all the systems are configured properly, the following icons are available in Phone Manager.  

   Book a Conference: Opens Conferencing Center Scheduler. 

  Join a Conference: Opens Conferencing Center Web Client. 
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Internet Security Changes 
Users of both Conferencing Center Web Scheduler and Client must have their internet security settings 
amended. If the settings are not changed they are not able to convert Microsoft files to MHT files. 

To amend the internet settings: 

1. Click Start > Settings > Control Panel. 

2. Click Internet Options. 

3. Click Security. 

4. Click Local Intranet. 

5. Click Custom Level. 

6. Scroll down to Initialize and script ActiveX controls not marked as safe. 

7. Select Enable. 

8. Click OK to save your changes. 

9. Click OK to close the 'Internet Properties' window. 

10. Close the 'Control Panel' window. 
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Voicemail Pro Configuration 
Create a Conference Access Short Code 
An internal Conference Center participant can use a short code to join a conference. When a short code 
is used you do not need to dial a bridge number.  

To create a conference access short code: 

1. Click Start > Programs > IP Office > Voicemail Pro. 

2. Right-click  Modules and click Add. 

3. In Name enter Conference and click OK. 
A Start Point for the new module is inserted in the Details pane. 

4. Click Start Point to select it. 

5. Click  Telephony Actions.  

6. Click  Conferencing Center. 

7. Click in the Details pane of the application to place the action. 

8. Click  Connection and link the Start Point action Next to Conferencing Center. 

9. Click  Save & Make Live.  

10. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  

11. Open IP Office Manager. 

12. Click and open the IP Office system configuration associated with Conferencing Center. 

13. In the Navigation pane click  Shortcode. 

14. Click  Create a New Record in the Group Pane. 

15. Complete the following fields. 

 Code: *90 
The code can be any available number though it must start with *. 

 Feature: Voicemail Collect 
Select from the drop down list. 

 Telephone Number: "Conference" 
The name of the Conferencing Center module. The name must be exact because 
Conferencing Center is case sensitive. It must also be in quotes.  

16. Click OK. 

17. Click  and send the configuration back to the IP Office.  

18. Test the short code.  
In the example you would dial *90. The phrase, "Please enter your conference ID and press # 
(pound/hash) to finish" should be played. 
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Conferencing Center Failure Routes 
When a participant dials into an active conference they are asked for the conference ID and PIN, if 
required. If incorrect information is entered you need to define what happens. We have provided 5 
sample failure routes that you can set up. Other failure routes can be created. 

The sample failure routes are: 

 Invalid ID or PIN. 
The failure route defines what happens when a participant enters an invalid conference ID or 
PIN. In the example the conference participant is transferred to the receptionist. For more 
information, see Invalid ID or PIN. 

 Conference not started. 
The failure route defines what happens when a participant dials into a conference that has not 
started. In the example the conference participant is played a message stating that the 
conference has not started. For more information, see Conference Not Started. 

 Conference Finished. 
The failure route defines what happens when a participant dials into a conference that has 
ended. In the example the conference participant is played a message stating that the 
conference has finished. For more information, see Conference Finished. 

 Conference Full. 
The failure route defines what happens when a participant dials into a conference that has 
reached its set number of participants. In the example the conference participant is played a 
"conference is full" message and then transferred to the receptionist. For more information, see 
Conference Full. 

 Conference Failure. 
The failure route defines what happens when there is a general failure in connecting to the 
conferencing system. In the example the conference participant is played a "conference failure" 
message and then transferred to the receptionist. For more information, see Conference Failure. 
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Invalid ID or PIN 
The failure route defines what happens when a participant enters an invalid conference ID or PIN. In the 
example the conference participant is transferred to the 
receptionist.

  

To create a invalid ID or PIN route: 

1. In Voicemail Pro, click the  Conference module. 

2. Right-click the  Conferencing Center action in the Details pane and select Properties. 

3. Click the Specific tab. 

 Click Gather conference and pin information before validation. 
This option is designed as an added security measure for joining a conference. If 
selected, the caller will be asked for the conference ID and PIN. The results are collected 
and then verified. If either entry is invalid, the caller is notified but not told which entry is 
incorrect. If this option is not selected, then the entries are validated as they are entered. 

 Select the number of times a conference ID can be entered before the failure route is 
activated. Up to 10 re-tries can be set. 

 Click OK. 

4. Click  Basic Actions. 

5. Click  Generic. 

6. Click in the Details pane to place the action. 

7. Right-click the  Generic action and select Properties.  

8. Click the General tab. 

 Change the Token Name to Play ConfInfo.wav.   

9. Click the Entry Prompts tab. 

 Click  (green cross). 

 In the field 'please select a file or enter a new file name' click . 

 Open the required language folder, en is English. 

 Select CONF_05.wav. The file will play “Your conference ID or PIN is not valid". 

 Click Open.  

 Click Close. 

 Click OK. 

10. Click  Connection and link Invalid Conference or Password action to  Play 
ConfInfo.wav. 

11. Click  Telephony Actions.  



Conferencing Center 

Applications Installation & Administration Manual Page 23 
IP Office 3.2 15-601133 Issue 1 (7 June 2006) 

12. Click  Transfer. 

13. Click in the Details pane to place the action. 

14. Right-click the   Transfer action and select Properties. 

15. Click the General tab. 

 Change the Token Name to Transfer Reception. 

16. Click the Specific tab 

 Enter the extension number of your reception in the Destination field. 

 Click OK. 

17. Click  Connection and link the  Play ConfInfo.wav Next action to  Transfer 
Reception. 

18. Click  Save & Make Live.  

19. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  
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Conference Not Started 
The failure route defines what happens when a participant dials into a conference that has no started. In 
the example the conference participant is played a message stating that the conference has no 
started..

  

To create a conference not started route: 

1. Create a recording similar to the following: 
“Sorry, the conference you are trying to join has not started yet. Please call back later.”  

2. Click  Basic Actions.  

3. Click  Generic. 

4. Click in the Details pane to place the action. 

5. Right-click the  Generic action and select Properties. 

6. Click the General tab. 

 Change the Token Name to Play NotStarted.wav.   

7. Click the Entry Prompts tab 

 Click the  (green cross). 

 In the field 'please select a file or enter a new file name' click . 

 Select the name of the wav file you created in step 1. 

 Click Open. 

 Click Close.  

 Click OK. 

8. Click Connection and link Conference Not Started action to  Play NotStarted.wav. 

9. Click  Basic Actions. 

10. Click   Disconnect. 

11. Click in the Details pane to place the action. 

12. Click Connection and link  Play NotStarted.wav Next action to   Disconnect. 

13. Click  Save & Make Live on the toolbar. 

14. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  
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Conference Finished 
The failure route defines what happens when a participant dials into a conference that has ended. In the 
example the conference participant is played a message stating that the conference 
finished.

   

To create a conference finished route: 

1. Create a recording similar to the following: 
“Sorry, the conference you are trying to join has already finished.”  

2. Click  Basic Actions.  

3. Click  Generic. 

4. Click in the Details pane to place the action. 

5. Right click the  Generic action and select Properties. 

6. Click the General tab. 

 Change the Token Name to Play Finished.wav.   

7. Click the Entry Prompts tab. 

 Click  (green cross). 

 In the field 'please select a files or enter a new file name' click . 

 Select the wav file you created in step 1. 

 Click Open.  

 Click Close. 

 Click OK. 

8. Click  Connection and link Conference Finished action to  Play Finished.wav. 

9. Click  Basic Actions. 

10. Click   Disconnect. 

11. Click in the details pane to place the action. 

12. Click  Connection and link  Play Finished.wav Next action to   Disconnect. 

13. Click  Save & Make Live. 

14. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  
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Conference Full 
This failure route defines what happens when a participant dials into a conference that has reached its 
set number of participants. In the example the conference participant is played a "conference is full" 
message and then transferred to the receptionist. 

 

To create a conference full route:  

1. Create a recording similar to the following: 
“Sorry, the conference you are trying to join is full.”  

2. Click  Basic Actions. 

3. Click  Generic. 

4. Click in the Details pane to place the action. 

5. Right-click the  Generic action and select properties. 

6. Click the General tab. 

 Change the Token Name to Play Full.wav.   

7. Click the Entry Prompts tab. 

 Click the  (green cross). 

 In the field 'please select a file or enter a new file name' click . 

 Select the name of the wav file you created in step 1. 

 Click Open. 

 Click Close. 

 Click OK. 

8. Click Connection and link Conference Full action to  Play Full.wav. 

9. Click  Telephony Actions. 

10. Click   Transfer. 

11. Click in the Details pane to place the action. 

12. Right-click the Transfer action and select Properties. 

13. Click the General tab. 

 Change the Token Name to Transfer to Reception. 

14. Click the Specific tab. 

 Enter the extension number of your reception in the Destination field. 

 Click OK. 
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15. Click Connection and link Play Full.wav Next action to Transfer Reception. 

16. Click Save & Make Live on the toolbar. 

17. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  
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Conference Failure 
This failure route defines what happens when there is a general failure in connecting to the conferencing 
system. In the example the conference participant is played a "conference failure" message and then 
transferred to the receptionist. 

 

To create a failure route:  

1. Click  Basic Actions 

2. Click   Generic. 

3. Click in the Details pane to place the action. 

4. Right-click the  Generic action and select Properties. 

5. Click the General tab. 

 Change the Token Name to Play Failure.wav.   

6. Click the Entry Prompts tab. 

 Click the  (green cross). 

 In the field 'please select a file or enter a new file name' click . 

 Open the required language folder, en is English. 

 Select the file CONF_23.wav. The wav file will play, “Conference not accessible”. 

 Click Open. 

 Click Close. 

 Click OK. 

7. Click  Connection and link Failure action to  Play Failure.wav. 

8. Click  Telephony Actions 

9. Click Transfer. 

10. Click in the Details pane to place the action. 

11. Right-click Transfer and select Properties. 

12. Click the General tab. 

 Change the Token Name to Transfer to Receptionist. 
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13. Click the Specific tab. 

 Enter the extension number of your reception in the Destination field. 

 Click OK. 

14. Click Connection and link Play Failure.wav Next action to Transfer to Receptionist. 

15. Click  Save & Make Live on the toolbar. 

16. When asked 'Any changes will be made permanent. Do you want to continue?' click Yes.  
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Configuring Conferencing Center 
Once Conferencing Center is installed, configuration changes can be made in the Conferencing Center 
Scheduler.  

Warning 

 Any configuration changes made here can greatly affect system performance. System features such 
as call intrusion, call recording and silent monitoring all use conference resources. for more 
information, see Conference Resources in the appendix. 

To configure Conferencing Center settings: 

1. Open an IE window. 

2. Enter http://<webserver_name>/avecs into the address field. The Conferencing Center Login 
window opens. 

3. Enter the User Id and Password for the Conferencing Center administrator. The User Id and 
Password were created during the installation. 

4. Click Logon. Conferencing Center Scheduler opens. The Pending Conferences screen shows 
that no conferences were found. 

5. Click OK.  

6. Click Configure. The Update Configuration window opens. 

 

Some updates will not happen until the ECS Conference Service (the name given to the Conferencing 
Center service) is stopped and restarted.  
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SMTP Server (Empty for Local) 
Enter the email server's address. This is required only if you are not using the SMTP service on the local 
machine. 

IP Office IP Address 
Enter the IP address of the IP Office control unit. 

IP Office Password/Confirm IP Office Password 
Enter the system password of the IP Office control unit. This is required by the conferencing server to 
access the IP Office control unit. 

Maximum Conference Duration: Default = 60 minutes. 
This will set the maximum length of time that a conference can be scheduled. 

Email From Address 
Enter an Email address from which conference notification emails are sent. The email account should 
represent a user account that has been created for the Conferencing Center server.  

Percent of Audio Resources Allocated : Default = 50%   
Audio resources reflect the audio channels available on the IP Office Control Unit. The percentage is 
taken from the total amount of audio resources allocated for the entire IP Office suite. The percentage of 
available resources can be altered if needed. Available resources will depend on the audio channels 
being taken up by the voicemail system and other systems that may use this resource. Audio channels 
are released at the end of every conference.   

If more resources need to be allocated because of user demand, move the bar accordingly, but 
remember that these resources may be used by other systems. Increasing resources for conferencing 
may greatly effect other systems, such as the Voicemail system. 

Note  

 Reducing resources may invalidate existing data. For example, if there are booked conferences that 
are relying on the pre-existing resources, configuration changes may make those conferences 
obsolete.      

Percent of Conference Resources Allocated: Default = 50% 
Conference resources reflect the conferencing channels available on the Control Unit. Conferencing 
channels are released after the end of every conference.    

Default Conference Language 
The language that every conference will be defaulted to. 

Default Conference Bridge Number 
Enter the bridge number for external participants to call and join an audio conference. The number is the 
default bridge number when a conference is booked. The conference scheduler can remove or update 
this number when booking a conference. The conference bridge number will be available on participants' 
confirmation emails if the email option is enabled.  

URL for Web Client 
Enter the path to the web server as follows: http://<web_server_name>/AVECSWEB. This URL will 
be available on participants' confirmation emails if Web Support and email options are enabled as part of 
the conference scheduling process.   

Conference End Warning (Mins): Default = 10 minutes 
An audio warning will be played X minutes prior the conference's scheduled end time, where X 
represents the number of minutes defined in this field. This value can be configured by the Conferencing 
Center user on a per conference basis.  
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Administration 
Hints and Tips 
Overview 
This section is intended to help the system administrator if any of the following issues happen. 

 Support for SQL  
The SQL versions supported for IP Office Applications. 

 Running ASP.NET on a domain controller 
An error happens if you try to run or debug an ASP.NET application on a domain controller or a 
backup domain controller. 

 Problems accessing web sites 
The pages http://pc_name/AVECS and http://pc_name/AVECSWEB do not load. 

 Network service error 
When logging into the Conferencing Center Scheduler an error message opens stating login 
failed for user 'NT Authority\Network Service'.  

 AVECS blank page 
When the AVECS web page is loaded, it is blank.  When the AVECSWEB web page is loaded, a 
single line of text is displayed. 

 Maximum logon attempts exceeded  
The error message Maximum logon attempts exceeded is shown. 

 Security setting error  
During the installation of Conference Center on a Windows 2003/2004 server, the error message 
1609 might show. 

 ECS service does not start 
The ECS Service will not start and a pop-up appears saying Could not start the ECS Conference 
Service service on Local Computer. 

 Emails not sent from the Conferencing Center server 
Mail is not being received correctly to either the mailbox or the Drop directory. 

 Email and smart hosts 
Setting Smart Host can enable SMTP forwarding. This option can be utilized if emails are unable 
to be sent from the Conference server. 

 SMTP notification failure  
SMTP notification may fail when authentication is required by a third party SMTP server. 
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Running ASP.NET on a Domain Controller 
Problem: 

By default, the worker process for Microsoft® ASP.NET (Aspnet_wp.exe) runs under the local machine 
account to restrict access to domain resources and provide a more secure environment. This will cause 
an error if you try to run or debug an ASP.NET application on a domain controller or a backup domain 
controller. On a domain controller, all user accounts are domain accounts and not local machine 
accounts, so Aspnet_wp.exe fails because it cannot find a local account named 
"localmachinename\ASPNET". 

Possible Solution: 

Create a "weak" account with the correct permissions: 

1. Create a user account on the computer and add this user account to the Users group. 

2. Grant this user account the Log On as a batch job right. This process may need to be repeated 
for the Domain Controller Security and Domain Security policies. 
To grant a user account the Log On as a batch job rights: 

 Click Start > Settings > Control Panel > Administrative Tools.  

 Double-click Local Security Policy. 

 Within the Local Security Policy window and under Security Settings, double-click 
Local Policies|User Rights Assignment. 

 In the list of policies, right-click the Log on as a batch job policy and click Security. 

 If the new user account does not appear in the Assigned To list, click Add to add the 
new user account. 

 Select the Local Policy Setting check box next to the user account name and click OK. 

 Restart the server, if necessary. 

3. Grant the new user account write access to the 
\WINNT\Microsoft.NET\Framework\V1.0.XXXX\Temporary ASP.NET Files\ directory. This will 
allow the Aspnet_wp.exe process to write temporary files and classes to this directory. Do the 
following to grant write access to the necessary directory: 

 Navigate to the \WINNT\Microsoft.NET\Framework\V1.0.XXXX\ directory in Microsoft 
Windows® Explorer and right-click the Temporary ASP.NET Files icon. 

 Click Properties and then click the Security tab. 

 Select the user account from the list and select the Allow check box for Write 
permissions. 

 Click OK. 

 Make sure that the new user account has access to all other files and directories that are 
necessary to serve ASP.NET pages. 

4. Grant the new user account write access to the \WINNT\TEMP\ directory. If you are running XML 
Web services, this will allow the Aspnet_wp.exe process to write temporary files and classes to 
this directory. Do the following to grant write access to the necessary directory: 

 Navigate to the \WINNT\TEMP\ directory in Windows Explorer and right-click the TEMP 
icon. 

 Click Properties and then click the Security tab. 

 Select the user account from the list and select the Allow check box for Write 
permissions. 

 Click OK. 

 Make sure that the new user account has access to all other files and directories that are 
necessary to serve ASP.NET pages. 
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5. Specify that the ASP.NET worker process will run under the new user account. 

 Open the \WINNT\Microsoft.NET\Framework\V1.0.XXXX\Config\Machine.config file. 

 In the <processModel> section, change the userName and password attributes to the 
name and password of the new user account. For example: 
userName="DomainName\ASPNETUSER" password="ASPNETUSERpassword". 

 Save the changes to the Machine.config file. 

 

Problems Accessing Web Sites 
Problem: 

Although on the local PC http://127.0.0.1/AVECS and http://127.0.0.1/AVECSWEB both load their 
respective pages correctly, http://pc_name/AVECS and http://pc_name/AVECSWEB does not load. 

Possible Solution: 
Ensure that the name of the PC does not contain an underscore or any other non-standard characters 
prohibited from the standard PC naming conventions. Permissible characters include: a-z, A-Z, 0-9 and 
hyphens (-).  
  

Maximum Logon Attempts Exceeded 
Problem: 
When the AVECS page is loaded, a grey error message is loaded, clicking Refresh loads the page 
successfully. However, after logging in, a message stating that the maximum logon attempts have been 
exceeded is displayed.  

Possible Solution: 
Check that the user ASPNET exists on the local PC. If the user does not exist, create the user by going 
into the Local Users and Groups setting via My Computer. 

 

Network Service Error 
Problem: 
When logging into the Conferencing Center Scheduler an error message opens stating login failed for 
user 'NT Authority\Network Service'. The error displayed on the grey background refers to 
NTAuthority\Network Service and is followed by the Max logon attempts error. Similarly, if the error 
states NTAuthority\Local Service, the corresponding procedure will need to be followed. 
 
Possible Solution: 
If this is running on a Windows 2003 Server, the following settings should be verified: 

1. Right click on My Computer, click Manage. 

2. Select IIS Manager > Local PC Name > Application Pools > DefaultAppPool 

3. Select Properties 

4. Select Identity and ensure Local System is set. 
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AVECS Blank Page 
Problem: 
When the AVECS web page is loaded, it is blank.  When the AVECSWEB web page is loaded, a single 
line of text is displayed.   
 
Possible Solution: 
Verify that there is a .aspx extension listed in IIS Manager. IIS Manager can be accessed by doing the 
following: 

1. Right click on the default web site. 

2. Select Properties. 

3. Click Home Directory. 

4. Click Configuration. The .aspx entry should be listed there. 
  

If not, it is likely that .NET 1.1 was installed prior to the installation of IIS. In this case, all of the system 
updates required have not been carried out.  

To re-install .NET 1.1: 

1. Remove .NET 1.1.  

2. Start installing Conference Server again so that .NET is installed from the Conferencing Center 
CD. 

3. When prompted to install the Conference Server press Cancel. 

4. Re-boot the server and check that the ASPNET user is present. 

 

 

Security Setting Error 
Problem: 

During the installation of Conference Center on a Windows 2003/2004 server, the error message 1609 
might show. 

Error 1609: An error occurred while applying security settings. ASP.NET is not a valid user or group. 
This could be a problem with the package, or a problem connecting to a domain controller on the 
network. Check your network connection and click Retry, or Cancel to end the install. 

Possible Solution: 
This is problem with ASP.NET. To resolve the problem: 

1. Check if .NET1.1 is installed. If it is, remove it. 

2. Start installing Conference Server again so that .NET is installed from the Conferencing Center 
CD. 

3. When prompted to install the Conference Server press Cancel. 

4. Re-boot the server and check that the ASP.NET user is present. 
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ECS Service Does Not Start 
Problem: 
The ECS Service will not start and a pop-up appears saying: 

Could not start the ECS Conference Service service on Local Computer.   
Error 1069: The server did not start due to a logon failure. 

Possible Solution: 
Check the ECS Service properties Log On tab and possibly change from Local Machine to 
.\Administrator to see if the service starts on higher administrative rights. 

The service should start on either local or Administrative rights depending on the server rights when 
loading the Conference Center software. Check with the domain administrator for the rights of the server 
being used. 

 

SMTP Notification Failure 
SMTP notification may fail when authentication is required by a third party SMTP server. 

Problem: 
If a third party SMTP server is used with the Conference Center software, the SMTP interface in 
Conference Center fails to run if authentication is required. If you put the IP address or name of a third 
party server directly into the configuration screen the email notification will fail. 

Possible Solution: 
Enabling 'Anonymous Access' in the third party SMTP server is required for the conference mail 
notification feature in Avaya Conference Center solution. 

An alternative resolution for this issue is to install a local SMTP server, gateway or other similar program 
on the same PC as the Conference Center to redirect the notification email. 

 

Email and Smart Hosts 
Setting Smart Host can enable SMTP forwarding to a SMTP server (e.g. Exchange Server) to forward 
email. This option can be utilized if emails are unable to be sent from the Conference server. 

1. Right-click on the properties of the SMTP Virtual Server and click on the delivery tab. 

2. Click on Advanced. 

3. Enter the Smart Host Domain name for the SMTP Server to be used. 

4. Apply new settings and close. 

If emails are failing to be sent after Smart Host has been enabled, copy the email from the 
InetPub\MailRoot\Queue to IntelPub\MailRoot\Drop. Booking a new conference with email will then send 
all emails from the drop directory. Thereafter all conferences with email notification enabled will have 
emails sent. 
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Emails Not Sent from the Conference Center Server  
Problem: 

Mail is not being received correctly to either the mailbox or the Drop directory. 

 

Possible Solution 1: 
On machines with IIS5, mail sent from the Conferencing Center Server will collect in 
.../InetPub/mailroot/Drop. If a POP3 Server has been installed on the PC, it will be taken from the Drop 
directory and delivered to the appropriate mailbox. 
 
On machines with IIS6 installed, provided the POP3 Server has been configured (this ships by default 
with Windows 2003), mail from the Conferencing Center Server will be routed correctly to the mailbox.  
 
If mail is not being received correctly to either the mailbox or the Drop Directory, it may be necessary to 
configure the SMTP Mail in IIS. 
 
To configure the SMTP Mail in IIS:  

1. From the Control Panel, open Internet Services Manager. 

2. Expand the tree and expand Default SMTP Virtual Server. 

3. If the domain name is not in the format X.X  

 Right click, select  New | Domain. 

 Select Alias and enter a name in the format X.X (e.g. PCSServer.Avaya.com). 

4. Double-click the Domain Name and ensure Drop Directory is set to 'Inetpub\Mailroot\Drop'. 
If the Virtual Server could not be viewed from the tree, update the server with all the latest 
Microsoft updates for the particular operating system being used. If after updating the server , the 
virtual server is still not shown: 

1. Un-install Microsoft IIS and SMTP 

2. Reinstall Microsoft IIS and SMTP 

3. Reinstall the .NET 1.2 (.NET will update IIS when installed). 

4. Reinstall the Conference Center software. 

 

Possible Solution 2: 
The email queue can be seen with each email to be sent from the Conference Server. If no emails are 
being sent check the queue folder in the InetPub\mailroot\queue. If this queue folder has several entries 
then ensure SMTP Virtual Server has been correctly established. If the SMTP settings have been 
correctly established, then refer to the section regarding Email and Smart Hosts. 

 

Support for SQL 
SQL 2005 is not currently supported for IP Office Applications. The currently supported versions are 
Microsoft SQL 2000 and MSDE. 
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Phone Manager 
Installation 
Overview 
This part of the guide covers the installation, configuration and administration support for IP Office Phone 
Manager.  

Phone Manager software is a single application that can be run in three modes:  

 Phone Manager Lite 
No license required.    

 Phone Manager Pro 
A 'Phone Manager Pro' license key is required for each Phone Manager Pro user. If insufficient 
licenses are available Phone Manager operates in Lite mode.  

 Agent Mode 
This mode is a selectable option available to users configured for Phone Manager Pro. In this 
mode the Phone Manager user has access to several agent related functions as toolbar icons.  

 Login Mode (Hot Desking) 
This mode is a selectable option available to users configured for Phone Manager Pro. Starting 
or stopping Phone Manager can be used to log the user on or off an extension. The extension is 
specified when starting Phone Manager. When logged on, the Phone Manager user's own 
extension number overrides the physical extension number.  

 Phone Manager Pro PC Softphone 
Each iPhone Manager Pro (VoIP) mode user requires a 'Phone Manager Pro' and a 'Phone 
Manager Pro IP Audio Enabled' license key. If insufficient licenses are available Phone Manager 
operates in Lite mode. 

The modes available are controlled by the Phone Manager licenses entered into the IP Office 
configuration. The mode for each user is set through the IP Office Manager program. For more 
information, see Selecting the Manager Type. 
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User PC Requirements 
There are minimum recommended PC specifications for Phone Manager Pro and Phone Manager VoIP. 

General 

Details 

License Phone Manager Pro (per user) - Enables Phone Manager Pro for 1, 5, 10, 20, 50, 100 
or unlimited users.   

Phone Manager Pro IP Audio Enabled (per seat) - Enables Phone Manager Pro IP 
Softphone operation for a user. The user also requires a Phone Manager Pro license. 

Languages Brazilian, Chinese (Simplified), Danish, Dutch, English, Finnish, French, German, 
Italian, Korean, Latin Spanish, Norwegian, Portuguese, Russian, Spanish and Swedish. 

Additional MS Internet Explorer 6.0 or higher 

Phone Manager Pro PC Softphone also requires the user's PC to have a speaker and 
microphone installed. The user must be associated with an IP extension on the IP 
Office. 

A sound card is needed if audio features are required. 

If installing Phone Manager Pro PC Softphone it is recommended that QoS is setup. 
For more information, see VoIP Quality of Service (QoS).  

 

Minimum PC specification for Phone Manager Pro and Lite 

RAM HD Pentium Celeron AMD XP Pro 2000 
Pro 

2000 
Server 

2003 
Server 

64MB 160Mb 800MHz Celeron 
3 

800MHz 

Althon 
B 

650Mhz 

    

 

Minimum PC specification for Phone Manager Pro PC Softphone 

RAM HD Pentium Celeron AMD XP Pro 2000 
Pro 

2000 
Server 

2003 
Server 

128MB 1GB 800MHz Celeron 
3 

800MHz 

Althon 
B 

650Mhz 

    

 

VoIP operation of Phone Manager is subject to the same requirements of VoIP network assessment as 
for any other IP Hardphone or Softphone installations. For remote PC VoIP operation, only VPN 
connections are supported. Non VPN connections might work but are not supported.  
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Planning Forms 
Completing the following details will assist in the installation of Phone Manager at a site.  

 Site Name: ___________________________________ 

 Customer Contact Name: ________________________ 

 Contact Telephone Number: ______________________ 

 

 IP Office System:  

 IP Address: ___:___:___:___ 

 Sub-Net Mask: ___:___:___:___ 

 

 Feature Key Dongle: 
Required if any users are to use Phone Manager Pro or iPhone Manager Pro (VoIP) modes.  

  Already installed /  Being installed at same time. 

 Dongle Type:  Serial /  Parallel /  USB. 

 Dongle Serial Number: ___________________________ 

 Feature Key Server PC: 
(Required for parallel or USB port feature key dongle). 

 IP Address: ___:___:___:___ 

 Sub-Net Mask: ___:___:___:___  

 

 License Keys: 
It is recommended that the Phone Manager license keys, if used, are obtained in the form of an 
electronic document from which they can be cut and pasted. This reduces the chance of errors 
during license key entry.  

License Name License Code Number of Seats 
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Phone Manager Users 
Real 
Name 

IP Office 
Name 

Ext. No. Password Phone 
Manager 
Type 

Agent 
Mode 

Default 
Login 
Extension 

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  

    Lite/Pro/VoIP Yes/No  
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Installing Phone Manager 
Overview 
The installation process is divided into the following steps. 

1. Planning forms 
Intended to assist in the installation of Phone Manager at site. The forms contain areas to record 
information about the site, IP Office system, Key Dongle details and a listing of the Phone 
Manager mode being used by extension number. For more information, see Planning Forms. 

2. Remove previous versions of the software. 
It is recommended that any previous installation of applications from the IP Office User suite are 
removed before installation. For more information, see Removing Old Phone Manager Software. 

3. Install the Phone Manager software. 
The process assumes that the user's PC is connected to the LAN and can see the IP Office. For 
more information, see Installing Phone Manager Software. 
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Installing Phone Manager Software 
This process assumes that the user's PC is connected to the LAN and able to see the IP Office.  

Note 

 If Phone Manager or an earlier version of IP Office User suite of software is already installed, this 
must be removed first. For more information, see Removing Old Phone Manager Software.  

 

To install Phone Manager: 

1. Insert the IP Office User Applications CD. The CD should auto-start the InstallShield Wizard. The 
'Setup Language' window opens.  

2. Select the language for the installation.  

3. Click Next. The 'Welcome to the InstallShield Wizard for IP Office User Suite' window opens. 

4. Click Next. The 'Customer Information' window opens. 

5. Type the User and Customer name. Select if the application is for anyone who uses the computer 
or only the named user. 

6. Click Next. The 'Choose Destination Location' window opens. Leave the directory setting at 
default unless absolutely necessary.  

7. Click Next. The 'Setup Type' Window opens. Accept the default setting of Typical. Phone 
Manager will be installed with all languages and TAPI. 

8. Click Next. The 'Start Copying Files' window opens. Settings can be changed at this stage.   

9. Click Back if to review or change any settings, 
or 
Click Next to begin copying the files. The 'Setup Status' window opens. The files may take a few 
minutes to install. The 'InstallShield Wizard Complete' window opens.  

10. Click Finish to exit the wizard. 

 

Phone Manager is installed and must be configured to work correctly. 

 



Phone Manager 

Applications Installation & Administration Manual Page 45 
IP Office 3.2 15-601133 Issue 1 (7 June 2006) 

Removing Old Phone Manager Software 
If there is a version of Phone Manager below 3.2 already installed, the application must be removed 
before installation. If the Phone Manager version is 3.2 or higher you can upgrade the software. For 
more information, see Upgrade Procedure. 

WARNING  
This process will remove all installed components of the IP Office User Suite. If any of the following IP 
Office applications are installed, ensure that they are reinstalled from the new IP Office User suite. 

 TAPI. 

 DevLink. 

 MS-CRM. 

 SoftConsole. 
  

To remove existing Phone Manager software: 

1. Select Start > Settings > Control Panel. 

2. Select Add/Remove Programs. 

3. From the list of Currently installed programs select IP Office User Suite.  

4. Click Change/Remove. The InstallShield Wizard for the software suite is started.  

5. When the option screen opens select Remove.  

6. When the option screen opens select Remove. You are asked Do you want to completely 
remove the selected application and all of its features? 

7. Click Yes. 

8. Once the suite has been removed, click Finish and close Add/Remove Programs. 

The Phone Manager software can now be installed. For more information, see Installing Phone Manager 
Software. 

 

Upgrade Procedure 
If the application software is 3.2 or higher you can upgrade the software. You do not have to removing 
the existing version of the software. 

To upgrade your applications: 

1. Insert the IP Office User Suite CD. The CD will auto-start the InstallShield Wizard. The 'Welcome 
to the InstallShield Wizard for IP Office User Suite' window opens.  

2. Click Next. The 'Upgrade Features' window opens. A list of features that can be upgraded is 
listed, for example: 

 Upgrade existing Phone Manager version xx to version xx. 

3. Select the options you want to upgrade, and de-select the options you do not want to upgrade. 

4. Click Next to upgrade. The Setup Status window opens. The selected features are upgraded. It 
may take a several minutes.  

5. The Update Complete window opens. Click Finish to exit the InstallShield Wizard. 
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Configuration 
Overview 
After installation the system must be configured to enable Phone Manager to work. All the changes are 
explained in the following sections. 

 License Keys 
A Phone Manager Pro license key is required for each Phone Manager Pro user. If insufficient 
licenses are available Phone Manager operates in Lite mode. For more information, see Entering 
License Keys. 

 Manager 
The IP Office Manager application needs to be updated with the Phone Manager type and 
general configuration recommendations. For more information, see Selecting the Phone Manager 
Type and IP Office Manager Configuration. 

 Play Sounds 
You can configure Phone Manager plays various sounds to announce calls ringing and waiting. 
For more information, see Play Sounds Option. 

 Instant Messaging 
When Instant messaging has been activated you can configure your operating system to give an 
audible alert when an instant message is received. For more information, see Configure Instant 
Messaging. 

 VoIP Mode Operation 
If you are using Phone Manager Pro VoIP additional settings in Manager on within Phone 
Manager must be applied. For more information, see Configure a PC Softphone. 

 Command Line Options 
Changes made to the command line options enable you to remove buttons from the Phone 
Manager toolbar and provide several shortcuts to Phone Manager on one PC. For more 
information, see Disabling Buttons and Logging in as a Specific User. 

 Popping External Programs 
Phone Manager Pro can be set to pop an external application whenever an incoming call arrives. 
The Phone Manager application 'Pops' to the front and becomes the foreground application. For 
more information, see Popping External Applications Overview.  
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Selecting the Phone Manager Type 
IP Office Manager is used to control the operation of specific functions of Phone Manager, for example 
the mode that Phone Manager runs in. By default Phone Manager will run as Phone Manager Lite. To 
select another mode the user configuration must be changed. 

To select the Phone Manager Type: 

1. Open IP Office Manager. 

2. Click and open the IP Office system configuration. 

3. Click and click the user's extension number in the Navigation pane. The options are shown in 
the Group Pane area. 

4. Select the Phone Manager Options tab. In Phone Manager Type select the mode required.  

 Lite - No license required. 

 Pro -  A 'Phone Manager Pro' license key is required for each Phone Manager Pro user. 

 Phone Manager PC Softphone -  Both a 'Phone Manager Pro' and a 'Phone Manager 
Pro IP Audio Enabled' license key are required for each iPhone Manager Pro (VoIP) 
mode user.  

5. Click OK.  

6. Repeat for any other users.  

7. Click  and send the configuration back to the IP Office.  
  

There are several configuration changes recommended for Phone Manager users. For more information, 
see IP Office Manager Configuration. 
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IP Office Manager Configuration 
There are several configuration changes recommended for Phone Manager users. 

 Turn on Call Waiting.   

 Turn on Busy on Held. 

 (Optional) Turn Off Hook Operation on.  
The recommended setting is On for Avaya digital phone users.  

 (Optional) Enable the Phone Manager user to book conferences using the Conference Center 
Scheduler. 

 (Optional) Set PIN restrictions. Pin restrictions are applied to external dialed numbers.   

 (Optional) Apply Account Codes. 

 

When Call Waiting is on there is an audible tone when you are on a call and another call arrives. Phone 
Manager allows the user to see the details of both calls and to switch between calls. This option is 
ignored for users logged on to phones with multiple call appearances.   

To turn on Call Waiting: 

1. Click  and click the user's extension number in the Navigation pane. The options are displayed 
in the Group Pane area. 

2. Select the Telephony tab.  

3. Check Call Waiting On. 

4. Click OK. 

5. Repeat for any other users.  

6. Click  and send the configuration back to the IP Office.  

 

When a call is placed on hold, it might be inconvenient to receive any further calls. It is recommended 
that Busy on Held is switched on. A busy tone is heard by further callers until the held caller is cleared. 
This option is ignored for users logged on to phones with multiple call appearances. 

To turn on Busy On Held: 

1. Click  and click the user's extension number in the Navigation pane. The options are shown in 
the Group Pane area. 

2. Select the Telephony tab.  

3. Check Busy On Held. 

4. Click OK. 

5. Repeat for any other users.  

6. Click  and send the configuration back to the IP Office.  
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Off Hook operation allows actions in Phone Manager, such as answer or make a call to be mirrored by 
the handset hook switch of the users telephone. Depending on the phones hands free capabilities this 
allows the user to answer, end and make calls purely using Phone Manager. 

To turn on Off Hook operation: 

1. Click  and click the user's extension number in the Navigation pane. The options are shown in 
the Group Pane area. 

2. Select the Telephony tab.  

3. Check Offhook Station.  

4. Click OK. 

5. Repeat for any other users.  

6. Click  and send the configuration back to the IP Office.  

 

PIN restrictions force the user to enter a valid account number if dialing an external number. If PIN 
restrictions are used the Account Code options are unavailable. PIN restrictions can be associated with 
types of numbers being dialed, for example International numbers. 

To set PIN Restrictions: 

1. In the Navigation pane click  ShortCode. Any existing short codes are listed. 

2. Click Create a New Record in the Group Pane. Select ShortCode. 
This Short code example is for any international numbers dialed from the UK.  

 

3. In the Code field enter the short code 00x xxx xxx xxxx.   
A PIN is requested when ever the user enters a telephone number starting with 00. 

4. In the Feature field select Dial. 

5. In the Telephone Number field enter a dot (.). The dot represents any number. 

6. Enter the Line Group Id that the short code is applied to. 

7. Click OK. 

8. Click  System. 

9. Select the Telephony tab.  

10. Remove the check for Show Account Code. 

11. Click OK. 

12. Click  and send the configuration back to the IP Office.  
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Account codes are used to track calls to specific external numbers. The Account Codes can use text and 
numbers. Account codes entered with calls are only recorded by the system if they match an account 
code already configured on the system. If the Account Code options are used the PIN restrictions 
options are unavailable.  

To enter Account Codes: 

1. In the Navigation pane click  Account Code. Any existing account codes are listed. 

2. Click Create a New Record in the Group Pane. Select Account Code. 

 

3. In the Account Code field, enter the code. 
Alphabetic characters can be used in account codes for users dialing from Phone Manager. 

4. (Optional) In the Caller ID field, entering a number means that the account code is automatically 
assigned to any incoming or outgoing calls with the same Caller ID. 

5. Click OK. 

6. In Phone Manager the Account Codes can be shown in a drop-down list where the user can 
select a valid account code. The drop down list is active if the Show Account Code option in the 
IP Office configuration is selected.  
To make the drop down list available to all users click  System > Telephony. The Show 
Account Code must be selected. 

7. Click OK. 

8. Click  and send the configuration back to the IP Office.  

 

If the system has an IP Office Conference Center server installed you can provide the Phone Manager 
user with icons to start the Conference Center Scheduler and Web Client. 

To enable Conference Center Scheduler booking: 

1. Click  and click the user's extension number in the Navigation pane. The options are shown in 
the Group Pane area. 

2. Select the Phone Manager Options tab.  

3. Check Book with Conference Center in Phone Manager  

4. Click OK.  

5. Repeat for any other users.  

6. Click  and send the configuration back to the IP Office.  
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Play Sounds Option 
The Play Sounds option within Phone Manager plays various sound through the user's PC multimedia 
setup to announce calls ringing and waiting. This option is available for all Phone Manager types. 

The following wav files are used for the Play Sounds option. They are located in the Phone Manager 
application folder c:\Program Files\Avaya\IP Office\Phone Manager.  

 NewCall.wav: Ringing. 
Separate files NewCall_Eng.wav and NewCall_enu.wav can be used to replace the file with ether 
UK or US ring tone respectively. 

 NewCallWaiting.wav: Ringing. 

 NewMessage.wav: “You have a new message” supplied in appropriate language variants. 

 Ding.wav: Ding. 

Note 

 The wav files can be replaced with custom recordings as long as they are in 16 bit mono wav file 
format.   

To turn on the Play Sounds option: 

1. Click  > Phone Manager. 
Alternatively, click View > Preferences > Phone Manager. The Phone Manager window opens. 
 

 
  

2. Check Play Sounds. Incoming calls are alerted by an incoming sound. 

3. Click OK to save your changes. 
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Configure Instant Messaging 
The Instant Messaging function of Phone Manager was developed and tested against Microsoft's Live 
Communication Server (LCS) 2003. It has also been run using LCS 2005. 

The LCS server requires both a Microsoft LCS server license and a LCS client license for each user. In 
addition, it requires each Phone Manager user to also have Windows Messenger installed and running.  

Requirements summary: 

1. LCS server PC requires: 

 LCS 2003 or 2005 with LCS Server license. 

 LCS client license for each user. 

2. IP Office Configuration requires: 

 The users SIP URI used for instant messaging should be entered as their Voicemail 
Email address in IP Office Manager. For example j.smith@acme.com would be entered 
as a voicemail email address in IP Office Manager. 

3. User PC requires: 

 Windows Messenger. 
This must be running and logged in at the same time as Phone Manager. 

 Phone Manager. 
  

Once these requirements are meet, Phone Manager must be configured. 

To activate IMS in Phone Manager: 

1. Open Phone Manager. 

2. Click  > Instant Messaging. 
Alternatively, click View > Preferences > Instant Messaging. The Instant Messaging window 
opens. 
 

 

3. To turn instant messaging on check Enable Instant Messaging Support. If you have connection 
to a Microsoft Live Communication Server you need to check this box for other users to add you 
as an Instant Message user.  

4. In the Server field, enter the name of the Microsoft Live Communication Server.  

5. In the user name field, enter your e-mail account and domain as configured on the Microsoft Live 
Communication Server. For example myname@myserver.com. 

6. In the Protocol field, click the type of protocol you are using to connect to the Microsoft Live 
Communication Server. You can choose from TCP, UDP and TLS. 

7. In the Password field, enter the password associated with your Instant Message profile. 
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8. (Optional) For Phone Manager to remember your password check Password. You do not have 
to re-enter your password if this box is checked. 

9. Click OK to save your changes. 

 

Notes 

1. Both users need to be enabled to send an Instant Message. 

2. You can Instant Message a user through the Speed Dial icons in the Speed Dial Call History 
Pane 

 

The Phone Manager does not give any audible alert when an instant message is received. However 
alerts can be configured through the Windows Control Panel.  

To configure an audible alert: 

1. Click Start > Settings > Control Panel. 

2. Select Sounds and Multimedia or Sounds and Audio.  

3. Select the Sounds tab.  

4. Scroll down the list of Program Events until the events for Windows Messenger are shown.  

5. Configure the events as required and click OK.  

Using the above option does require that Windows Messenger is running when a message is received 
even though the message is being handled through Phone Manager. 
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VoIP Mode Operation 
Notes 

 Phone Manager Pro VoIP cannot register with an IP Office that does not have a System Name. 
This applies for all VoIP extensions. Ensure the switch has a name before connecting to it. 

 If the audio codec is changed in Phone Manager, the application must be restarted for the 
change to take effect.  

 If the main window does not appear after a long time this may be because Phone Manager is 
trying to communicate with the VoIP server and the server is not responding. Use the Windows 
Task Manager to terminate the process 'iClaritySrv.exe' and 'phonemanager.exe' and restart the 
phone manager. 

 Windows 2000. 
If Phone Manager PC Softphone operation appears to be degraded when the user performs 
operations such as scrolling through a large document, the priority given by the PC to the 
iClaritySrv.exe task should be increased.  

1. Open the Windows Task Manager and select the Processes tab.  

2. Locate the iClaritySrc.exe process.  

3. Right-click on it and select Set Priority.  

4. Increase the priority as required.    

 Phone Manager checks for the presence of a sound card and if none is installed the speaker and 
the microphone icons are disabled. To use VoIP the microphone must be selected as the 
recording device and not muted. On some soundcards this is not the default and must be set 
manually.  

 The speaker and microphone mute feature is only available if the sound card supports it.  

 Enable faststart and Use direct media should be set for the VoIP extension.  

 Offhook station should be set for the user associated with this VoIP extension. 

 Phone Manager does not allow the user to specify which audio device to use for VoIP Phone 
Manager. It always uses the default device specified under the multimedia tab in the control 
panel. 

 When using the VoIP feature make sure the Use only preferred devices tick box in the Audio 
tab is selected. The Audio tab is in the Sounds and Audio Devices option in the Control Panel. 
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Configure a PC Softphone 

The presence of the  and  icons indicate that Phone Manager is running in VoIP mode. The title 
bar should also state Phone Manager iPro or Phone Manager SoftPhone.   

To make the changes required in Manager: 

1. There must be both a Phone Manager Pro and a Phone Manager Pro IP Audio Enabled license 
available when the user starts Phone Manager.  

2. Changes to the user: 

 The user must be associated with an IP extension with Allow Direct Media Path 
selected. 

 Click the Phone Manager Options tab. 
- Select Phone Manager PC Softphone  
- Check the option PC Softphone mode. 

 Click the Telephony tab. 
- Check Offhook Station. 

 

The PC must be enabled for audio playback and recording via an installed soundcard or USB 
microphone headset. Phone Manager checks for this when started.  

To make the changes in Phone Manager: 

1. Click  > Phone Manager. 
Alternatively, click View > Preferences > Phone Manager. The Phone Manager window opens. 
 

 

2. Check Play Sounds. Incoming calls are alerted by an incoming sound. 

3. Check Enable VoIP.  

4. Click OK to save your changes. 
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5. Click  > Audio Codec 
Alternatively, click View > Preferences > Audio Codec. The Audio Codec window opens. 

 

6. Select one of the four industry standard audio codecs, as the preferred audio codec for VoIP 
communication. 

 Use  &  to select the audio codec required. 

7. (Optional) If you are using a low bandwidth connection for example a dial Up Modem, increasing 
the Frames per packet to 2 might improve the quality of the VoIP communication. However this is 
not guaranteed. If you are not using a low bandwidth connection it is recommended you use the 
default value of 1. 

8. (Optional) If you have multiple IP connections select Confirm VoIP IP Address. Prompts you to 
select the IP address for VoIP communication.  

9. (Optional) Select Enable FastStart to provide the caller with a ring tone. If it is not checked the 
caller does not hear ring tone, but the call is connected faster. 

10. Click OK to save the changes. 

11. Close Phone Manager. When you next start Phone Manager the options selected will be active. 

 

Note 

 QoS support from the users PC is optional but is highly recommended. Windows 2000 and 
Windows XP are able to provide the user with QoS that can be configure to match the QoS 
settings of the IP Office. See VoIP Quality of Service (QoS).   

 

WARNING - To change the settings you must be connected to the telephone switch. 
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VoIP Quality of Service (QoS) 
iPhone Manager Pro can support DiffServ QoS when running on Windows 2000 and Windows XP. 
However it requires QoS to be enabled within Windows. It is still dependent of QoS being supported at 
all hub/routing points between the user and the IP Office.  

Note 

 The default DSCP (DiffServ Control Point) value used by Windows is 40 unless overridden. This 
differs from the IP Office system default of  46.   

 

Windows XP 
The network card/interface being used must support 802.1p and the Windows QoS Scheduler must be 
installed. The DSCP value might need to be changed. 

To change the DSCP value:  

1. Select Start > Run and enter gpedit.msc.  

2. Open Local Computer Policy > Computer Configuration > Administrative Templates > 
Network > QoS Packet Scheduler. 

3. For the Guaranteed Service Type enter the required DSCP value.  

 

Windows 2000 
 The network card/interface being used must support 802.1p. 

 The following DWORD registry key must be added and set to 0 to enable DSCP marking. 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters\D
isableUserTosSetting 

 To change the DSCP value to match that being used by the IP Office network, add the following 
DWORD registry key set to the required value.  
HKEY_CURRENT_USER\Software\Avaya\IP400\PhoneManager\DSCP 
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Command Line Options 
Disabling Buttons 
You can disable the conference calls  and transfer call buttons to minimize the risk of accidental 
conference or transfer. This might be required in sensitive environments where conflicting parties may be 
held at the same time. The functions are still available in the Functions menu.  

To disable buttons: 

1. Right-click on the Phone Manager shortcut and select Properties. 

2. Select the Shortcut tab. 

3. The Target will be similar to:  
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe"  
 
After the closing quotation mark, add -disable:ConferenceButton and/or -
disable:TransferButton as required. For example: "C:\Program Files\Avaya\IP 
Office\Phone Manager\PhoneManager.exe" -disable:ConferenceButton -
disable:TransferButton  

4. Click OK. 

5. Test the shortcut.  

 

Logging in as a Specific User 
In situations where users share a PC without logging on or off to Windows, it may be more convenient to 
have several shortcuts to Phone Manager. Each shortcut can be configured for a different user. This can 
be done by adding the user name and password to the separate Phone Manager shortcuts rather than 
changing it each time through File> Login.  

To create a shortcut: 

1. Right-click on the Phone Manager shortcut and select Properties. 

2. Select the Shortcut tab. 

3. The Target will be similar to: 
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe". 
 
After the closing quotation mark, add the IP Office IP Address, the User Name in quotation marks 
and the user password in quotation marks. If the password is blank add "". For example: 
 
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" 192.168.42.1 Extn201 
""  

4. Click OK. 

5. Test the shortcut. 
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No Sound Check 
There are some installations where, even though no Phone Manager sound features are being used a 
"Mixer Not Detected" error appears each time Phone Manager is started. This can be suppressed 
using the -nosoundcheck command line option. 

To suppress error message: 

1. Right-click on the Phone Manager shortcut and select Properties. 

2. Select the Shortcut tab. 

3. The Target will be similar to: 
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe". 
 
After the closing quotation mark, add -nosoundcheck. For example: 
 
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" -nosundcheck  

4. Click OK. 

5. Test the shortcut. 
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Popping External Applications 
Overview 
Phone Manager Pro can be set to pop an external application whenever an incoming call arrives. The 
Phone Manager application 'Pops' to the front and becomes the foreground application.  

In addition to starting an external application, Phone Manager Pro also passes some basic call data to 
that external application. The data passed is:  

 Calling Party 
The number of the calling party if available. 

 Called Party 
Usually the number of the Phone Manager Pro extension. 

 Tag 
Any name or other information associated with the call. Phone Manager and SoftConsole can be 
used to add a tag to a call before it is made or transferred. 

 Account Code 
Any account code matched against the Caller ID of the call in the IP Office configuration 
directory.   

 Display Text 
Similar to the text string shown on display phones by IP Office when calls ring.  

 

 

The content management packages that have been tested are: 

 ACT! 6.0 and 7.0  

 Goldmine 6.0 and 6.7  

 Maximizer 7.5 Enterprise  

 Microsoft Outlook (2000, 2003 and XP).   

Screen popping requires the selected application to be running with the appropriate database at the 
same time as Phone Manager Pro.   

The option Pop External Application is a special option that allows the passing of call data from Phone 
Manager Pro to a custom application.  

The screen pop action is based on calling number (ICLID) matching. Screen popping on DDI/DID can be 
enabled. For more information, see Screen Pop on DDI.  
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Phone Manager Configuration 
Phone Manager needs to be configured so that contact details can be shown. The screen pop options 
are only available when the content management packages are installed and detected by Phone 
Manager. 

To configure Phone Manager: 

1. Click  > Screen Pop. 
Alternatively, click View > Preferences > Screen Pop. The Screen Pop window opens. 
 

 

2. Select the Phone Number option. 

 Internal - Check this box to pop the Phone Manager for internal numbers. 

 External - Check this box to pop the Phone Manager for external numbers. 

3. Select the Phone Mode option: 

 Ringing - Check this box to pop Phone Manager when the telephone rings. 

 Answering - Check this box to pop Phone Manager when you answer the telephone. 

4. In the Program to Pop field, enter the content management package that you want to use. 

5. The content management package must be configured. Click Configure.   

6. Enter the required information depending on the content management package you selected. 

 ACT! - Enter your database file name (.dbf), the name of your Database and your 
password of the Act! Database. 

 Goldmine - Enter the path of the Server (gmw6.exe) 

 Maximizer - Enter the path of the Server (Maxwin.exe) 

 External - This is a Third party External Program specifier that is executed when normal 
popping would occur. Several call parameters are passed to the external program when 
called. For more information, see the Applications Installation and Administration guide. 

7. (Optional) Select the Outlook option.  
If there are no matches for the incoming call in the selected content management package, 
Outlook is checked for a matching entry in the default Contacts folder. If the incoming number 
matches a number in one of your contacts that contact will pop up. MAPI must be installed on 
your PC for this facility to be available. For more information, see your system administrator.  

8. Click OK. 
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9. Click OK to save your changes. 

Note 

 The ACT!, Goldmine or Maximizer database needs to be open on your desktop. The record of the 
caller pops in receipt of the call. 

 

Screen Pop on DDI 
In default screen pop is based on ICLID (CLI/CLID) matching. This can be switched to DDI/DID matching 
if required. To do this you need to edit the Windows registry. Screen pop on DDI/DID does not currently 
work with Outlook. It works with ACT!, Goldmine and Maximizer. 

Warning 
Editing the Windows Registry should only be done by experience Windows maintainers. Ensure that a 
backup of the registry has been taken. If you are not sure how to do this you should not attempt to edit 
the registry. 

To screen pop on DDI: 

1. Select Start > Run.  

2. Enter regedit and click OK.  

3. Within the left-hand panel, open the path 
HKEY_CURRENT_USER/Software/Avaya/IP400/PhoneManager. 

4. Right-click in the right panel and select New DWord. 

5. Change the name to PopOnDDI. 

6. Double-click PopOnDDI.  

7. Change Value data: to 1 and click OK.  

8. Close the Registry Editor. 

 

Selecting Fully Delimited Data 
By default the pop external application data is delimited with spaces. The action below enables delimiting 
with " characters. 

Warning 
Editing the Windows Registry should only be done by experience Windows maintainers. Ensure that a 
backup of the registry has been taken. If you are not sure how to do this you should not attempt to edit 
the registry. 
  

To select fully delimited data: 

1. Click Start > Run.  

2. Enter regedit and click OK.  

3. In the left panel, open the path 
HKEY_CURRENT_USER/Software/Avaya/IP400/PhoneManager. 

4. In the right panel locate the registry key PopExtProgFullParam.  
The default value is 0, which sets Phone Manager Pro to output the call data using spaces as 
field delimiters. 

5. Double-click PopExtProgFullParam.  

6. Change Value data: to 1 and click OK.  
The user's Phone Manager Pro will now output the call data with " characters surrounding each 
field. 

7. Close the Registry Editor. 
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Microsoft Outlook Notes 
Phone Manager disables Outlook related functions if a suitable version of Outlook 2000, 2003 or XP is 
not found during installation. Outlook 2000 or higher must be installed to enable these functions. Outlook 
Express is not supported.  

Note 

 Phone Manager uses MAPI to perform a CLI match for pop outlook. If the user does not have a 
default profile or no profile exist then this function will not work.  

Phone Manager only screen pops against the user's personal mailbox contacts, mailbox contacts and 
public folder contacts. Where duplicate entries exist that order is the order of preference.  

To enable screen pop using Microsoft Outlook Notes: 

1. Click Contacts > Properties > Outlook Address Book > Show this folder as an email 
address book. 

2. Click OK. 
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Administration 
General Notes 

 Phone Manager indicates it is connected to the switch by showing the user name inside a pair of 
square brackets '[ ]'. If the title bar displays 'Phone Manager' it is not connected to the switch.  

 Only one instance of Phone Manager can be run at a time. When starting Phone Manager, if an 
existing instance of Phone Manager is detected, the additional Phone Manager will exit silently. 

 Phone Manager checks with the switch once every minute for the availability of the Voicemail 
Server. The record and message panes are enabled or disabled accordingly. If the messages 
pane is unavailable, check the status of the Voicemail Server. 

 Do not connect 2 or more Phone Managers to the switch using the same user name, especially 
when Phone Manager is operating in VoIP mode. This will lead to unpredictable or incorrect 
operation of Phone Manager. 

 The number of licenses available and the number still free can be checked through any running 
copy of Phone Manager. The licences are unique to the serial number of the Feature Key dongle 
being used by the IP Office system.  
 
To check the number of unused licenses: 

1. Select Help > About Phone Manager.  

2. Hold down the Ctrl and Shift keys. Click the software version number.  
A list of licenses is shown. 

 

Phone Manager Ports and Firewalls 
Phone Manager uses the following IP ports for communication with the IP Office. If a firewall is placed 
between the user PC and the IP Office, traffic on these ports should be allowed. 

 Port 69 on the IP Office and the Phone Manager PC- TFTP 
This is used by the Phone Manager to obtain data from the IP Office such as user name lists and 
the switch directory. TFTP is also used during the application log on. 

 Port 50796 on the IP Office - IPO PC Partner 
This port is used by Phone Manager and Soft Console applications to establish communication 
with the IP Office for call signalling, configuration changes, etc. 

 Port 50799 on the Phone Manager PC - IPO BLF Updates  
Used by Phone Manager to receive status updates for internal speed dial icons. These are sent 
from the IP Office using the 255.255.255.255 broadcast address.  

 VoIP 
Phone Manager Pro PC Softphone uses ports 1719 and 1720 for H323 Gatekeeper discover and 
then a range of ports for VoIP. Therefore we can only recommend Phone Manager Pro PC 
Softphone operation across a firewall when using VPN to tunnel the connection.  
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User Settings and Profiles 
For Phone Manager 3.0 onwards, all user settings are stored in a single local profile file. The exception 
is local directory numbers. The profile file name matches the user's extension number, for example 
212.xml. By default the files are stored in My Documents\Avaya\IP 400\PhoneManager\Profiles.  

This file is created when a user with that extension number first uses Phone Manager. The file is not 
deleted by removal of the Phone Manager application and a separate file is created for each extension 
number using Phone Manager on that PC and that particular PC log on.     

Within Phone Manager the File > Save Profile option can be used to save a copy of the profile to a 
different location. You can load a profile from a different location using the option File > Load Profile. 
When loading a profile, the file name must match the user's extension number. 

 

Directory Entries 
User directory entries entered through Phone Manager are saved to the file 
PhoneManagerDirectory.txt. This file is stored in My Document\Avaya\IP 
Office\PhoneManager.   

The file is a CSV format file in the format: 

 Name -  The name to display in the directory. 

 Number -  The telephone number. 

 wavfile - The path to the wav file to associate with the directory entry. 

 scriptfile - The path to the script file to associate with the directory entry. This file can be a plain 
text file or an RTF format file.  

 

You can use Phone Manager to edit the contents and to import or export directory files.  

To configure the directory in Phone Manager: 

1. Click File > Directory. 

2. Make the changes as required. 

3. Click Close to save the changes. 

 

Note 

 A large directory can degrade the performance of Phone Manager as excessive CLI lookups and 
other actions have to be performed whenever a call arrives or is made. The recommended 
maximum number of directory entries is 1000.  
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Citrix/Thin Client Phone Manager 
Phone Manager has been tested with Citrix. It is supported in Phone Manager Lite and Phone Manager 
Pro modes but not in iPhone Manager Pro (VoIP) mode.  

Features Supported: 

 Phone Manager Lite and Phone Manager Pro.  

 Screen popping to Outlook, Goldmine and Maximizer (not ACT!).  

 Call recording and mailbox access to Voicemail Pro.  
  

Features Not Supported: 

 Phone Manager Pro Softphone (VoIP) mode.  
This is because of the inability to allow upstream audio on a Citrix server with Client Audio 
Mapping.  

 Play Sound functions.  
Some support is possible if the -nosoundcheck command line option is used and client computer 
has an audio card correctly mapped. However some delay in the playing of sound might be 
experienced.  

 The 'Hide on Close' option should not be used.  

 

Notes 

1. The default skin of Phone Manager can cause issues for some thin client installations. You can 
run Phone Manager without a skin by creating a empty text file called skin.ini. In Phone Manager 
load the new skin.ini file. For more information,  see Loading a Skin. 

2. A maximum of 5 users are supported using Citrix/Thin Client Phone Manager. 

3. No other IP Office User CD applications have been tested on Citrix.  

 

Loading a Skin 
When a custom skin has been created it can be loaded into the Phone Manager. For more information, 
see Creating Custom Skins in the appendix. 

To load a new skin in Phone Manager: 

1. Click View > Load Skin. 

2. Browse to the folder containing the new skin and select the skin.ini file.  

 Phone Manager skin files are located by default in:  
C:\Program Files\Avaya\IP Office\Phone Manager\Skin\ 

3. Click OK.  
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SoftConsole 
Installation 
Overview 
This part of the guide covers the installation, configuration and general administration of IP Office 
SoftConsole.  

SoftConsole is intended primarily for operators and receptionists. It is designed to work in parallel with a 
physical telephone. The telephone provides the operators speech path and SoftConsole provides call 
controls.   

Note 

 SoftConsole cannot be used in full softphone mode, for example it does not support the PC also 
being used as a softphone. 

 

The key features are: 

 Large display for incoming call information. 

 Searchable directory of all IP Office groups and users including status information. 

 Visual display of queued calls. 

 Visual display of the status of extensions. 

 Up to 16 call parking areas. 

 Mobile Twinning. 
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Pre-Installation Requirements 
Check the following requirements before attempting to install SoftConsole.  

General 

Details 

License SoftConsole (users) - Allows the first instance of IP Office SoftConsole to be run. 

eBLF - Adds one additional SoftConsole user. A maximum of four SoftConsole users 
can be licensed. 

Languages Brazilian, Chinese (Simplified), Danish, Dutch, English, Finnish, French, German, 
Italian, Korean, Latin Spanish, Norwegian, Portuguese, Russian, Spanish and 
Swedish. 

Additional Sound and media files can be associated with calls. If this feature is to be used then 
the PC requires a sound card and speakers to be installed.  

 

Minimum PC specification 

RAM HD Pentium Celeron AMD XP Pro 2000 
Pro 

2000 
Server 

2003 
Server 

128MD 1GB 800MHz Celeron 3 
800MHz 

AthlonB 
650MHz 
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Installation 
If there is a version of SoftConsole installed that is below 3.2, the application must be removed before 
the new software can be installed. For more information, see Removing Old SoftConsole Software. If the 
SoftConsole version is 3.2 or above the software can be upgraded. For more information, see Upgrade 
Procedure. 

This process assumes that the PC is connected to the LAN and can communicate with the IP Office.  

To install SoftConsole software: 

1. Insert the IP Office User Applications CD. The CD should auto-start the InstallShield Wizard. The 
'Choose the language for Installation' window opens.  

2. Select the language for the installation. Click Next. The 'Welcome to the InstallShield Wizard for 
IP Office User Suite' window opens.  

3. Click Next. The 'Customer Information' window opens. Enter your user and company name. 
Select to install the application so that anyone who uses the computer can use SoftConsole or 
only the person entered in the user name field. 

4. Click Next.  The 'Choose Destination Location' window opens. Leave the destination folder 
setting at default unless absolutely necessary.  

5. Click Next. The 'Setup Type' Window opens.   

6. Select Custom.  

7. Click Next. The 'Select Features' window opens. 

8. De-select the Phone Manager option and select the SoftConsole option. 

9. Click Next. The 'Start Copying Files' window opens. Settings can be changed at this stage.   

10. Click Back to review or change any settings 
or 
Click Next to begin copying the files. The 'Setup Status' window opens. The SoftConsole files 
may take a few minutes to install. 

11. The 'InstallShield Wizard Complete' window opens. Click Finish to exit the wizard. 

 

SoftConsole is installed and now needs to be configured. 
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Upgrade procedure 
Removing Old SoftConsole Software 
If there is a version of SoftConsole below 3.2 already installed, the application must be removed.  The 
new version of software can then be installed. 

If the SoftConsole version is 3.2 or higher you can upgrade the software. For more information, see 
Upgrade Procedure. 

WARNING  
This process will remove all installed components of the IP Office User Suite. If any of the following IP 
Office applications are installed, ensure that they are reinstalled from the new IP Office User suite. 

 TAPI. 

 DevLink. 

 MS-CRM. 

 Phone Manager. 
  

To remove existing SoftConsole software: 

1. Select Start > Settings > Control Panel. 

2. Select Add/Remove Programs. 

3. From the list of Currently installed programs select IP Office User Suite.  

4. Click Change/Remove. The InstallShield Wizard for the software suite is started.  

5. When the option screen opens select Remove. You are asked Do you want to completely 
remove the selected application and all of its features? 

6. Click Yes. 

7. Once the suite has been removed, click Finish and close Add/Remove Programs.  

You can now install the new version of SoftConsole. For more information, see Installing SoftConsole. 

 

Upgrade Procedure 
If the application software is 3.2 or higher you can upgrade the software, without having to removing the 
existing version. 

To upgrade your applications: 

1. Insert the IP Office User Suite CD. The CD will auto-start the InstallShield Wizard. The 'Welcome 
to the InstallShield Wizard for IP Office User Suite' window opens.  

2. Click Next. The 'Upgrade Features' window opens. A list of features that can be upgraded is 
listed, for example: 

 Upgrade existing SoftConsole version xx to version xx. 

3. Select the options you want to upgrade, and de-select the options you do not want to upgrade. 

4. Click Next to upgrade. The Setup Status window opens. The selected features are upgraded. It 
may take a several minutes.  

5. The Update Complete window opens. Click Finish to exit the InstallShield Wizard. 
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Configuration 
Changes in Manager Application 
There are a number of recommended configuration changes for users who want to be SoftConsole 
operators. 

 Mark a user as being a SoftConsole Operator.  

 If there is more than one operator it is recommended that they are placed into a hunt group. Call 
routing and distribution is then available between the SoftConsole operators. The IP Office can 
support up to 4 simultaneous SoftConsole operators.  

 If the SoftConsole users are members of a group, voicemail for that group should be switched off 
unless specifically required. 

 Unanswered calls should be returned to the SoftConsole operator. If no transfer time is set, calls 
are not returned to the operator. 

 Turn Busy on Hold off.  
When a SoftConsole operator places a call on hold, incoming calls do not get the busy tone. 

 Allow the SoftConsole operator to send a short text message to a user with an Avaya display 
telephone. 

 

To make changes in Manager: 

1. Open IP Office Manager. 

2. Click  and load the IP Office system configuration. 

3. Make the configuration changes to the hunt group and user. 

 

If there is more than one operator it is recommended that they are placed in a hunt group. 

To add an extension number to a hunt group: 

1. Click  and open the hunt group for SoftConsole operators. 

2. In the Details pane under the extension list area, click Add. 

3. Select the operator's extension number and include it in the selected extensions listing. 

4. Click OK. 

5. Make sure that the check box by the new extension is selected. 

6. Click OK. 
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The configuration of the operator's extension number can be changed. 

To amend the extension number: 

1. Click  and click the user's extension number in the Navigation pane. The options are displayed 
in the Group Pane area. 

2. Select the Phone Manager Options tab. 

 SoftConsole User 
Select the option SoftConsole user to allow the user to be a SoftConsole operator.  

3. (Optional) Select the Voicemail tab. 

 If voicemail is switched on you need to provide the users with message waiting indication 
for new hunt group voicemail messages.   
Click Source Numbers tab. Add an Hname entry (replacing name with the group name) 
for the hunt group. 

4. Select the Telephony tab. 

  Transfer Return Time (secs)  
By default, when the SoftConsole operator does an unsupervised transfer, the call rings 
the transfer number until answered or the caller hangs up. The call does not return to the 
SoftConsole operator. When a transfer return time is set, unanswered calls are returned 
to the operator and (NoAns) is displayed in the Call Information window.  

 Busy on Held 
We recommend that this is turned Off so that when the SoftConsole operator places a call 
on hold, additional incoming calls do not get busy tone. 

  System Phone 
Select this option to let the user use the SoftConsole's Send Message function.  

 

Command Line Options 
The following command line option can be used with SoftConsole:  

oncall  
This will show the Caller ID (if available) of the calling/called party a user is talking to when that user is 
busy. Use and support of this feature may be subject to local restrictions in some countries.  

Information shown without the -oncall option. 

  

Information shown with the -oncall option. 
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Applying Command Line Options 
The following methods apply to programs started via the Windows Start menu. For programs started 
from a desktop icon, the Target path can be edited by right-clicking on the desktop icon and selecting 
Properties. 

Windows 2000 

1. Right-click on the Windows taskbar and select Properties.  
The Taskbar and Start Menu Properties window opens. 

2. Select the Advanced tab and click on the Advanced button. The Explorer window opens. 

3. Locate the shortcuts for the IP Office programs. These are normally in C:\Documents and 
Settings\ All Users\Start Menu\Programs\IP Office.  

4. Right-click on the shortcut icon for SoftConsole and select Properties.  

5. Edit the Target path to include the command line option.  
 
The example below shows a Target path for SoftConsole set to oncall. Enter the quote marks as 
shown though they may be automatically removed if they are not required by the system. 
 
C:\Program Files\Avaya\IP Office\SoftConsole\"SoftConsole.exe" "-oncall" 

6. Click OK. 

7. Close the Explorer window. 

8. Click on OK in the Taskbar and Start Menu Properties window. 

 

Windows XP 

1. Right-click on the Windows taskbar and select Properties.  
The Taskbar and Start Menu Properties window opens. 

2. Select the Start Menu tab and click on the Customize button. From the Customize Start Menu 
click the Advanced button. This will open an Explorer window. 

3. Locate the shortcuts for the IP Office programs. These are normally in C:\Document 
Settings\All Users\Start Menu\Programs\IP Office.  

4. Right-click on the shortcut icon for SoftConsole and select Properties. View the Shortcut tab. 

5. Edit the Target path to include the command line option.   
 
The example below shows a Target path for SoftConsole set to oncall. Enter the quote marks as 
shown though they may be automatically removed if they are not required by the system. 
 
C:\Program Files\Avaya\IP Office\SoftConsole\"SoftConsole.exe" "-oncall"  

6. Click OK. 

7. Close the Explorer window. 

8. Click on OK in the Customize Start Menu window. 

9. Click on OK in the Taskbar Properties window. 
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Administration 
Exporting Directories 
Directory entries can be exported in a .CSV file format. User, Hunt Group, and Directory entries can all 
be exported as well as the directory entries from the IP Office switch and entries in the Microsoft Outlook 
Contacts folder. 

To export a directory: 

1.  Select the directory to export. 
The directories shown in the Directories panel will be exported. Use the Show/Hide buttons to 
select the entries to be exported. 

 User Entries. 

 Hunt Group Entries. 

 SoftConsole Local Directory entries including any entries from the IP Office switch and 
entries in the Microsoft Outlook Contacts folder. 

2.  From the Directory menu select Export. 

3.  Enter a name for the file and click OK. 

 

The exported directory will be, by default, created in the Data directory of the program. If an existing file 
name is selected the original file contents are overwritten. This folder location contains the LocalDir.csv 
files that SoftConsole uses. DO NOT overwrite with an export function. 

Note  

 The available Directories are selected from the Directories Configuration form within Options.  
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Delete a Profile 
Profiles can be removed if they are no longer required. 

To delete a profile: 

1. Click File > Save Profile As. 

2. Select the profile to be deleted. 

3. Press Delete on your keyboard. 

4. The message Are you sure that you want to send 'profile name.pfs' to the Recycle Bin? is shown. 
Click Yes. 

5. To return to the SoftConsole main window click Save.  

 

Directory Paths 
SoftConsole is installed by default under the directory path: 

Program Files\Avaya\IP Office\SoftConsole.  

Sub-directories are created enabling the user to save specific information when required. 

 Data 
the directory contains data files for the local directory. This is the default directory when browsing 
for a data file, or when exporting a directory to file. 

 Langs 
The directory contains language specific files including Help and Tutorials. 

 Profiles 
The directory contains the user profiles (*.pfs) that are available to the SoftConsole application. 
Initially this directory contains only the default templates. When using the 'Save As' command, 
profiles or templates are saved in this directory. Only profiles and templates saved in this 
directory are available from the SoftConsole Login window. 

 Script 
The directory contains the script file (*.txt or *.rtf) to open on DDI/DID matching. This is the 
default directory to open when browsing for a script. New script files should be copied into this 
directory. 

 Skin 
The directory is the default location for any custom skins that have been created.  For more 
information, see Creating Custom Skins in the appendix. 
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Hints and Tips 
Microsoft Outlook Warning Screen Appears 
If directory access to Microsoft Outlook Contacts folder has been selected in the directories configuration 
form, a Microsoft Outlook warning screen might appear when an operator is opening SoftConsole or 
using the option 'Send Email'. For more information refer to the Microsoft Support web site. 

If the warning screen appears: 

1. Select the Allow access for checkbox, and then click an amount of time in the list. 

2. Click Yes.  
Yes should always be selected to allow SoftConsole to retrieve Outlook contacts. 

 

Loading Custom Skins 
When a custom skin has been created it can be loaded into the SoftConsole application. For more 
information, see Creating Custom Skins in the Appendix. 

To load a new skin in SoftConsole: 

1. Click Tools > Preferences - Configure > Appearance. 

2. Check Apply Custom Skin. 

3. Enter the file path of the skin file or click Browse, select the skin.ini file that represents your 
chosen skin, then click Open. 

4. Click OK.  
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Appendix 
BLF Operation 
This section describes the BLF operation on the IP Office Phone Manager and SoftConsole applications.  

BLF notifications are broadcast onto the same subnet as that of the IP Office. IP Office also supports 
BLF notifications to a maximum of 10 Unicasts to IP Addresses on different subnets that can be used by 
other devices, such as SoftConsole and Phone Manager. 

When 10 Unicast IP addresses have been established, any subsequent IP connection attempts will 
connect, however they will not be provided BLF broadcast. 

On a system restart, the first 10 applications on a different IP subnet that require BLF notifications will be 
able to secure a BLF broadcast. Subsequent application connections on a different subnet will not be 
provided BLF notifications. 
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Conference Resources 
A conference can be created using Conferencing Center, Phone Manager or SoftConsole. Each time a 
conference is created resources are used. All the applications share the same conference resources.  

System features such as call intrusion, call recording and silent monitoring all use conference resources. 
This includes automatic recording if enabled. When any of these features are active, the number of slots 
available for conference parties is reduced.  

The number of internal users and external callers that can be involved in conferences at the same time is 
limited by the conference capacity of your IP Office telephone system.  

 

IP Office Maximum callers in any 
one conference 

Maximum total 
number of people on 

conference calls 

Maximum number of 
Conferences on the 

system 

Small Office 
Edition 

6 24 8 

IP403 64 64 21 

IP406 64 64 21 

IP412 64 128 42 

Note 

 If IP Office Conferencing Center is installed, 5 resources are reserved for use by the system, for 
example, call recording. The maximum number of callers in any one conference and the total 
number of people on conference calls is reduced by 5. The maximum number of conferences on 
the system for IP403, IP406 and IP412 is reduced by 2. 

 

Examples 

1. IP403 and IP 406 support multiple conferences adding up to 64 callers in conferences.  

 21 x 3 way conferences 

 1 x 10 way conference plus 11 x 3 way conferences. Free capacity for 20 more 
conference callers to join new or existing conferences. 

2. IP412 supports multiple conferences totaling up to 128 callers in conference with no more than 
64 callers in any one conference. 

 The IP412 supports two 63 party conference banks. When a new conference is started, 
the bank with the most free capacity is used for that conference. However once a 
conference is started on one conference bank, that conference cannot use any free 
capacity from the other conference bank.  
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Entering License Keys 
This section assumes that the IP Office feature Key dongle has already been installed and setup (plus 
the Feature Key server software if required). If this is not the case refer to the IP Office Feature Key 
Server manual.  

To enter license keys in IP Office Manager: 

1. Make sure that you have the list of licenses ready and that they match the serial number of the 
dongle being used by the IP Office.  

 Preferably the licenses should be in an electronic document from which they can be cut 
and pasted into the configuration. This reduces the chances of errors in the license entry.  

2. Open IP Office Manager. 

3. Click  and open the IP Office system configuration.  

4. In the Navigation pane click  License. Any existing licenses are listed. 

5. Click Create a New Record in the Group Pane. Select License. 

 

6. Enter the license key in the license key field. 

 If the licenses are in an electronic format copy the license and paste in the license Key 
field.   

7. Press Tab. The license Type field is automatically completed. 

8. Click OK. The Status of the newly entered license is Unknown.   

 Repeat steps 5 - 8 for any additional licenses.  

9. Click  and send the configuration back to the IP Office. If the only changes made were to add 
license keys, this can be done using merge.  

10. Click  and open the IP Office system configuration again.  

11. In the Navigation pane click  License.  

12. Verify that the Status of the license has changed to Valid.  

 If a license is listed as Invalid, ensure that it was entered correctly. If necessary refer to 
the IP Office Feature Key Server manual. 
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Customizing the Look 
Creating Custom Skins 
This section describes the requirements for creating and loading a skin for use on the IP Office Phone 
Manager and SoftConsole applications. However it does not attempt to teach how to use the required 
Skin Development application.  

The example shown is Phone Manager with a skin called 'Gradic' loaded. 

 

 

To Create a Skin.  
If you want to create a skin then skin development software is required. In the example the Business 
Skin Form from Almediadev (SkinBuilder.exe) was used. Trial software and a number of samples are 
available from www.almdev.com.  

The SkinBuilder.exe application must be used to create or edit a skin. This application allows you to 
manipulate your skin visually and has a built-in tester to test your skin definition.  
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Phone Manager Skin Objects and Controls 
To create a new skin make a copy of the Avaya skin definition folder in the skin directory (C:\Program 
Files\Avaya\IP Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your 
design. Modify the bitmaps, the skin objects and the skin controls.  

There are a number of sections in the Avaya skin definition ini file. The following tables describe the 
various sections in the ini file. 

SECTION DESCRIPTION 

Version  Version information and comments. 

Pictures   Bitmap files used by the skin definition. 

FormInfo  Bitmaps for the main window. 

PopupWindow  Bitmaps for any pop up windows (menu etc). 

HintWindow  Bitmaps for tool tip. 

SkinObjects  Windows elements pertaining to the main window; caption bar, menu bar, 
maximize, minimize and close buttons. 

 

The following SkinObjects need to be defined for the Phone Manager main window. 

 closebutton - Bitmap for the close button in the main window. 

 maxbutton - Bitmap for the maximize button in the main window. 

 systembutton - Bitmap for the system menu button in the main window. 

 minbutton - Bitmap for the minimize button in the main window. 

 mainmenubaritem - Bitmap for each item in the menu bar. 

 caption - Bitmap for the main window caption bar. 

 menuitem - Bitmap for each item in the drop down menu. 

 menubarsystemmenubutton - Bitmap for the system menu button on the main menu bar. 

 menubarclosebutton - Bitmap for close button on the main menu bar. 

 menubarmaxbutton - Bitmap for maximize button on the main menu bar. 

 menubarminbutton - Bitmap for the minimize button on the main menu bar. 
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The following SkinControls need to be defined in Phone Manager. 

 Tab - Bitmaps for the tabs; In, Out, All, Missed, Messages, Speed dials, etc. 

 Panel - Bitmaps for the panels used in various dialogs; Make Call, Directory, Config PBX, etc.  

 Toolbutton - Bitmaps for buttons in the toolbar (except for the volume control, see the 
toolmenutrackbutton). 

 Mainpanel - Bitmap for the background of the main window. 

 Button - Bitmaps for push buttons in the main window. 

 Controlbar - Bitmap for the background of the toolbar area. 

 Toolpanel - Bitmap for the background of each toolbar. 

 mainmenubar - Bitmap for the background of the main menu bar. 

 Checkbox - Bitmaps for check boxes. 

 Stdlabel - Bitmaps for labels. 

 groupbox - Bitmaps for group boxes. 

 edit - Bitmaps for edit controls. 

 toolmenutrackbutton - Bitmaps for the volume control buttons on the toolbar. 

 vscrollbar - Bitmaps for the vertical scroll bar used in various places. 

 updown - Bitmaps for the up/down button to scroll the tabs. 

 trackbar - Bitmaps for the volume control slider. 

 

Phone Manager uses a second ini file called dialog.in1 to define the appearance of the dialogs. The 
following tables describe the various sections in the ini file. 

 FormInfo - Bitmaps for the dialog box. 

 caption - Bitmaps for the dialog box caption bar. 

 close - Bitmaps for the dialog box close button. 

 button - Bitmaps for push buttons in the dialog that resides inside a panel. 
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SoftConsole Skin Objects and Controls 
SoftConsole Skin Objects and Controls 
To create a new skin make a copy of the Avaya skin definition folder in the skin directory (C:\Program 
Files\Avaya\IP Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your 
design, modify the bitmaps, the skin objects and the skin controls.  

There are a number of sections in the Avaya skin definition ini file. The following tables describe the 
various sections in the ini file. 

SECTION DESCRIPTION 

Version  Version information and comments. 

Pictures   Bitmap files used by the skin definition. 

FormInfo  Bitmaps for the main window. 

PopupWindow  Bitmaps for any pop up windows (menu etc). 

HintWindow  Bitmaps for tool tip. 

SkinObjects  Windows elements pertaining to the main window; caption bar, menu bar, 
maximize, minimize and close buttons. 

 

The following SkinObjects need to be defined for SoftConsole.  

 caption - Bitmap for the form's title bar.  

 closebutton - Bitmaps for the Close button in the form's title bar.  

 minimizebutton - Bitmaps for the Minimize button in the form's title bar.  

 maximizebutton - Bitmaps for the Maximize button in the form's title bar.  

 mainmenubaritem - Bitmaps for the menu items on the form's main menu.  

 sysmenubutton - Bitmaps for the System Menu button in the form's title bar.  

 menuitem - Bitmaps for the drop down menus of the form's main menu. 
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The following SkinControls need to be defined for SoftConsole. 

 panel - Background bitmap for dialog boxes and for various panels on the main form. 

 button - Bitmaps for standard button controls.   

 toolpanel - Background bitmap for the Directory and Held Calls toolbars on the main form. 

 toolbutton - Bitmaps for button controls on the Directory and Held Calls toolbars on the main 
form.  

 bigtoolpanel - Background bitmap for the main tool bar on the main form.  

 bigtoolbutton - Bitmaps for button controls on the main tool bar of the main form.  

 resizebutton - Bitmaps for list view column headings.  

 mainmenubar - Background bitmap for the main menu bar on the main form.  

 statusbar - Background bitmap for the status bar controls.  

 statuspanel - Background bitmap for panels within a status bar control. 

 stdlabel - Attributes of label controls. 

 listview - Bitmap for list view controls. 

 hscrollbar - Bitmaps for horizontal scroll bar controls.  

 vscrollbar - Bitmaps for vertical scroll bar controls. 

 bothhscrollbar - Bitmaps for displaying vertical and horizontal scroll bar controls simultaneously.  

 vsplitter - Bitmap for vertical splitter controls on the main form.  

 hsplitter - Bitmap for horizontal splitter controls on the main form.  

 tab - Bitmaps for tab sheet controls.  

 hupdown - Bitmaps for left/right arrow controls used for navigating through tab sheets when all 
of the tabs cannot be displayed)  

 vupdown - Bitmaps for up/down arrow controls used for navigating through tab sheets when all 
of the tabs cannot be displayed) 

 bevel - Bitmap for bevel controls. 

 checkbox - Bitmaps for check box controls.  

 radiobox - Bitmaps for radio controls.  

 groupbox - Bitmaps for group box controls.  
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